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Part I
Software Virtualization Solution Overview

This part includes the following chapters that provide an overview of Software 
Virtualization Solution.

Introducing Altiris® Software Virtualization Solution™ (page 8)

Understanding Software Virtualization Solution (page 11)



 

Chapter 1
Introducing Altiris® Software Virtualization 
Solution™

Altiris® Software Virtualization Solution™ (SVS) is a revolutionary approach to software 
management. By placing applications and data into managed units called Virtual 
Software Packages, Software Virtualization Solution lets you instantly activate, 
deactivate or reset applications and to completely avoid conflicts between applications 
without altering the base Windows installation.

Software Virtualization Solution is based on Altiris patents-pending core technology 
known as the SVS File System Filter driver.

Software Virtualization Solution leverages the Altiris Extensible Management 
Architecture of Notification Server, the Altiris Agent, and the Altiris Console.

This chapter contains the following topics:

Solving Problems with Software Virtualization Solution (page 8)

Software Virtualization Solution Benefits (page 9)

Product Documentation (page 10)

Solving Problems with Software Virtualization 
Solution

Software Virtualization Solution solves the following common application management 
problems:

Provisioning and deprovisioning applications is disruptive to the user 
and time consuming

With Software Virtualization Solution, you can easily deploy virtualized applications 
without running an application install or uninstall on client computers. Application 
availability is instantaneous—you can easily and immediately activate or deactivate your 
applications by sending a single command to the client computer. The user is not 
required to have system rights to run an installation, and you don’t have to worry about 
restarting when you activate or deactivate an application. The solution can also register 
any services that the application installed with the Windows Service Control Manager, 
which then loads the service so that the application is fully functional.

Recovering a damaged application is time consuming

Rather than repairing or recovering a damaged application, you can simply reset it to 
the original deployed condition. Application resets can be performed instantly or on a 
schedule. An application can be reset whether the client computer is connected to the 
network or not. Resetting a virtual application does not damage other applications 
installed on the computer.
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Conflicting applications are difficult or impossible to manage

Software Virtualization Solution ensures applications use the correct files and registry 
settings without modifying the operating system and interfering with other applications. 
This provides numerous benefits, including improved reliability and flexibility. Example: 
When installing new software or application updates, administrators might inadvertently 
replace newer .DLLs with older .DLLs, which can cause immediate problems between 
applications sharing those .DLLs, causing application failure or reintroducing security 
holes that previously were patched. With Software Virtualization Solution, you can stop 
worrying about “DLL hell.”

Other benefits include allowing different versions of the same application to co-exist on 
the same computer. Also, virtualized applications will never corrupt an operation system.

Migrating to new application versions requires significant testing and 
planning; takes a long time to execute and rollback is difficult

Rolling out new versions of an application requires significant time to test for conflicts 
and reprovisiong lab testing computers. Software Virtualization Solution simplifies pre-
deployment testing, accelerates the deployment cycle, and reduces post-deployment 
support costs. With Software Virtualization Solution, you can host multiple versions of 
an application on the same system without conflicts between older and newer files.

Even phased rollouts are greatly accelerated because rollback can occur immediately at 
any time. Once the transition from an older application to a newer application is 
complete, simply deactivate and remove the older version.

Software Virtualization Solution Benefits
Integrates With Altiris® Extensible Management Architecture™

Software Virtualization Solution integrates with Altiris® Extensible Management 
Architecture™ (EMA™), so you benefit from native integration with Altiris service 
management, asset management, and systems management solutions. Take advantage 
of reports and policies that let you quickly troubleshoot and better forecast potential 
system problems. Example: Altiris pre-packaged Web Reports™ allow you to drill down 
for detailed information about your environment.And not only does EMA let you leverage 
your existing investment in Altiris solutions, it also makes it easy to extend capabilities 
as your business grows and your business needs change.

Supports Any Management Framework

Software Virtualization Solution is designed to work independently of the Altiris 
framework, if desired. API, WMI, and command-line interfaces are supported. This 
means Software Virtualization Solution client-side operations can be managed with any 
desktop management product.

Low Overhead Without Compromising Application Performance

Other vendors run virtualized applications inside a proprietary isolation wrapper, which 
introduces more performance overhead. Software Virtualization Solution incurs 
negligible overhead; the core of the system is a filter driver that is around 160 KB.
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Product Documentation

The following documentation is provided with Software Virtualization Solution: 

Release Notes. The Altiris Software Virtualization Solution Releases Notes contain 
a list of the new features and known issues in this version of the product. It also 
contains any last-minute information that is not included in the main 
documentation.

Altiris Software Virtualization Solution Reference. The Altiris Software 
Virtualization Solution Reference provides complete product documentation for 
administrators.

Altiris product documentation is available in Microsoft HTML Help (.CHM) and Adobe 
Acrobat (.PDF) formats. Documentation files are installed in the following directory:

C:\Program Files\Altiris\Notification Server\NSCap\Help

You can access documentation from the Altiris Console by clicking the following icons in 
the upper-right corner of the Altiris Console:

The complete and most current versions of documentation are available from the Altiris 
Knowledge Base, which is available from the Altiris support Web page at 
www.altiris.com/support.

Altiris Juice

Additional information can be found the Software Virtualization Solution Web 
Community Web site called Juice. The Juice Web site provides articles, tools, and tips to 
help you maximize the benefits of Software Virtualization Solution. You can visit the 
Juice at http://www.altiris.com/juice.

Access the contextual online help by clicking the online help icon.

Access an index of all help by clicking the index icon.
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Chapter 2
Understanding Software Virtualization Solution

This chapter helps you understand Software Virtualization Solution (SVS) and includes 
the following topics:

How Software Virtualization Works (page 11)

Software Virtualization Solution Usage Scenarios (page 16)

Software Virtualization Solution Limitations (page 20)

Software Virtualization Solution Glossary (page 21)

How Software Virtualization Works
An application or set of data is virtualized by using a capture process that creates a 
Virtual Software Package (VSP). A VSP contains all the files and registry settings of the 
application or data. A VSP can be used on a client computer that has the Software 
Virtualization Agent. The VSP is installed to a special area on the hard drive. After the 
VSP is activated through the Software Virtualization Agent, the application becomes 
visible along with its files, folders, and settings. Even though it is a “virtual” application, 
it looks and behaves like any other application to the end user.

This section describes the following topics:

Software Virtualization and Redirection (page 11)

Virtual Software Package Architecture (page 13)

Layer Architecture (page 13)

Layer Actions and States (page 14)

Software Virtualization and Variablization (page 16)

Software Virtualization and Redirection
Each VSP is managed by SVS as a distinct entity. When activated, VSPs are like “layers” 
over the base Windows operating system so the system appears to contain the 
aggregate contents of the base Operating System plus the active VSPs.

When a VSP is imported onto a computer, the contents of the VSP (both files and 
registry settings) are placed in a folder in a special protected SVS area on the hard dive, 
referred to as the SVS redirection area. 

When a VSP is imported on a client computer, the contents of the VSP are placed in the 
redirected folder, such as C:\fslrdr\1. When the VSP is activated on a client computer, 
the contents of the VSP are made available to the user. The files and settings appear to 
the user in the location they would be in if the application had been installed on the 
computer.

Example: You have a VSP for Mozilla Firefox. When the Firefox VSP is activated, all the 
contents of the VSP are “layered” over the base file system and registry to make it 
visible to the user. The user then sees it’s appropriate folders, files, registry settings, 
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and shortcuts. When the contents are made visible, they are not displayed in the hidden 
area, but they are displayed in the locations that the user would see them had Firefox 
been installed on the computer. Example: Even though the Firefox application file may 
physically be located at 

C:\fslrdr\1\PROGRAMFILES\Mozilla Firefox\firefox.exe 

to the user, it is visible as 

C:\Program Files\Mozilla Firefox\firefox.exe

Software Virtualization Solution accomplishes this by using a filter that intercepts 
requests to the file system and registry, and when needed, redirects requests to the 
active VSPs. Software Virtualization Solution uses the SVS File System Filter Driver to 
aggregate the real and virtual file systems into one view for the end-user. The SVS File 
System Filter Driver is the main component of the Software Virtualization Agent. The 
Software Virtualization Agent must be installed on any computer that you want to use 
VSPs on.

Example: The Firefox VSP is active. When a user browses to C:\Program Files\, all the 
subfolders in the actual file system folder appear, but the filter driver also looks at any 
active VSPs, and in this case, also displays the folder C:\Program Files\Mozilla Firefox.

With redirection, SVS can maintain discrete settings and file versions for different 
applications on a single system. By working with VSPs, a required version of a file will 
never be overwritten. This is particularly important when you are working with Dynamic 
Link Libraries (DLL). Incompatible .DLL files are known to cause application instability. 
By using applications within VSP, you can ensure that applications use its own set of 
.DLL files without interfering with the rest of the operating system or other applications 
running at the same time.

This extends not only to files that relate to applications, but also to registry settings and 
data files.
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Virtual Software Package Architecture

A Virtual Software Package (VSP) is a generic term used for a set of captured data in its 
complete life-cycle while being managed by SVS. A VSP can be in one of two formats: a 
“Virtual Software Layer” or a “Virtual Software Archive” file.

Virtual Software Layers

When an application or set of data is captured into a Virtual Software Package, 
everything that is captured is contained in a “layer.” The “layer” represents all the files 
and registry settings that make up the virtualized application or data. 

Typically, one layer is created for one application. However, one layer can contain 
multiple applications. Each layer is managed as a single entity.

The files and settings captured in a layer are stored in the SVS redirection area on the 
computer’s hard drive. However, when a layer is active, all files and settings appear in 
the system just as they would if the application or data was installed on the computer. 
This is accomplished through redirection using the SVS File System Filter Driver.

Virtual Software Archive (VSA) files

If you want to make a layer portable so that it can be used on another computer, the 
contents of the layer are exported to a single Virtual Software Archive (VSA) file. These 
archive files have a .VSA extension.

VSA files can then be copied or deployed to other computers. To make the contents of 
the VSA usable on a computer, the VSA must be imported using the Software 
Virtualization Agent. When a VSA is imported on a computer, the layer (the files and 
registry settings in the VSA) are installed to the SVS redirection area on the client 
computer’s hard drive.

Layer Architecture
There are two components or sublayers in a layer:

Read-only sublayer Contains all captured files and settings.

Writeable sublayer Contains any files or settings that are added or changed by 
a user of a layer.
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Example: You create a layer for Firefox. As a person uses Firefox, they may make some 
changes to the program. They may select a unique home page, add bookmarks, or 
change the original security settings. They may also install a browser plug-in. Those 
user changes are stored in the Writeable sublayer. The original files and settings are 
maintained in the Read-only sublayer.

Having these distinct sublayers is useful in being able to reset a layer. When a layer is 
reset, any data added by a user is deleted, and the layer is returned to its original 
configuration.

Example: If a user’s Firefox application ever becomes damaged, you can simply reset 
the layer to restore it to the way it was first deployed. The application does not have to 
be uninstalled/reinstalled.

Resetting layers also maintains specific versions and configurations of applications 
across your network. You can control how the applications are installed and configured 
on client computers.

Note
The two sublayers currently apply only to virtualized application layers, not data layers.

Caution
When you reset a layer, any data that is written to the Writeable sublayer will be lost. 
For information, see Resetting Layers (page 37).

Layer Actions and States
You can perform the following actions on layers:

Name Description

Layer Actions

Import The layer files in a VSA file are installed in the hidden SVS 
redirection area on the client computer. However, imported files 
are not visible until the layer is activated.

Read-only 
Sublayer

Writeable 
Sublayer

VSP

Virtual 
Software 
Package

.VSA

Virtual 
Software 
Archive

 

Layer
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Software Virtualization Workflow

Activate The layer files that have been imported on a client computer are 
made visible to the user. Activation and deactivation occur almost 
instantaneously.

Deactivate The imported layer files are hidden from the user but are kept on 
the computer. 

Note
You cannot deactivate a layer while a process is running from that 
layer. For information, see Deactivating Layers with Services 
Running (page 37).

Deactivate 
(Force)

The layer is forcefully deactivated by killing all the running 
applications from that layer. This might cause undesired results.

Delete The imported layer files are removed from the computer.

Delete (Force) The layer is forcefully removed by killing all the running 
applications from that layer. This might cause undesired results.

Reset Deletes all of the user’s profiles in a layer that were added or 
changed. The data in the Writeable sublayer is deleted, leaving 
only the files in the Read-only sublayer. See Resetting Layers 
(page 37).

Note
Data layers cannot be reset. Hence, “Reset”, “Reset and Activate” 
and “Reset and Deactivate” are not available for data layers.

Reset (Force) Deletes all of the user’s profiles in a layer that were added or 
changed, killing all the running applications from that layer. This 
might cause undesired results.

Layer States

Activated The imported layer files are made visible to the user.

Deactivated The imported layer files are hidden from the user.

Combination 
of Actions and 
States

Import and 
Activate

The layer files are placed in the SVS redirection area on the client 
computer and are made visible to the user.

Reset and 
Activate

The layer files are reset to their original imported state by 
deleting all user data and changes (Writeable sublayer), and the 
layer is visible to the user.

Reset and 
Deactivate

The layer files are reset to their original imported state by 
deleting all user data and changes (Writeable sublayer), and the 
layer is not visible to the user.

Name Description
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The following diagram illustrates a typical Software Virtualization workflow:

1. Using Software Virtualization Solution tools (SVS Admin), capture an application 
into a layer.

2. To make the layer portable, export the layer to a Virtual Software Archive (VSA) file.

3. Deploy the VSA to a client computer.

4. Import the VSA into a layer on the client computer.

5. Activate the layer to access the application.

Software Virtualization and Variablization
Many applications have specific environment settings for file paths, paths in registry 
values, MSI paths, and so forth. To make VSPs portable across computers, many 
application settings and data layer properties are variablized by Software Virtualization 
Solution.

Example: SVS uses common system variables to substitute for well-known locations on 
a Microsoft Windows based installation, such as WINDIR as a substitute for the 
“Windows” folder. This provides seamless compatibility with systems that may not be 
using the standard folder structure, such as systems that have moved their “My 
Documents” folder or that have renamed OS folders.

Example: If you have a VSP for My Documents, it may be on C drive on one computer 
but on D drive on another computer. Variablization allows the data layer to work 
correctly on both computers. For information, see View Variables used in a Layer 
(page 47).

Software Virtualization Solution Usage Scenarios
This section describes the different ways you can use Software Virtualization Solution.

What Can be Virtualized? (page 17)

What Cannot be Virtualized? (page 17)

How are Applications and Data Virtualized? (page 17)

How Can Virtual Software Packages be Used? (page 17)

How does Software Virtualization Solution Affect my Network? (page 18)

How does Software Virtualization Solution Affect Client Computers? on page 19
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What Can be Virtualized?

You can virtualize applications and collections of data.

Application Layers

Most every application can be virtualized, including office applications, databases, 
Internet browsers, media, and spyware utilities. Applications function normally when 
virtualized by SVS. All functionality and configuration options are available to the user.

Data Layers

You can also redirect user data to be stored within a layer. (Example: All files created 
with a .DOC extension can be stored within a layer, letting users easily group their 
documents together. Users can also define folders in the same way.) (Example: The “My 
Documents” folder can be redirected to a data layer.) By giving multiple paths and 
directing that content to a data layer, you can manage all user content invisibly. Coupled 
with the layer import/export function, this lets a user copy not only an application from 
one machine to another, but also all of their customizations and files. By having data 
files in their own layers, those files are protected when application layers are reset and 
writeable data in those layers are lost. For information, see Creating and Using Virtual 
Data Layers (page 34).

What Cannot be Virtualized?
Some applications and file types do not work well virtualized at this time. For 
information, see Software Virtualization Solution Limitations (page 20).

How are Applications and Data Virtualized?
Virtualized applications and data are captured into Virtual Software Packages using a 
simple capture tool called Software Virtualization Solution Admin tool (SVS Admin). 
Virtual Software Packages contain all the files and registry settings required for an 
application to run. 

How Can Virtual Software Packages be Used?
Virtual Software Packages are highly portable and can be easily used between different 
computers and Windows operating system versions. The virtualization technology is 
invisible to the user, the applications, and operation system, yet virtualized applications 
and data are visible system-wide and execute normally. Virtualization has negligible 
system and performance overhead.

You can use Virtual Software Packages in the following environments:

Using Software Virtualization Solution Stand-alone

Using Software Virtualization Solution in an Altiris® Notification Server Environment

Using Software Virtualization Solution in an Altiris® Deployment Solution™ 
Environment

Using Software Virtualization Solution Stand-alone 

You can use Virtual Software Packages in a stand-alone environment on Windows-based 
computers. To use Virtual Software Packages, install the Software Virtualization Solution 
Admin tool on a computer and then create or import existing Virtual Software Packages. 
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For information, see Getting Started with Virtual Software Layers and Archive Files 
(page 24).

You can use the Software Virtualization Solution for Personal Use version to create and 
use your own virtual layers in a single-computer environment. 

You can also make VSA files available to network users by using network shares, login 
scripts, SMS, and so forth. 

For information, visit the Juice at http://www.altiris.com/juice.

Using Software Virtualization Solution in an Altiris® Notification 
Server Environment

Using the Notification Server-based Software Virtualization Solution, you can remotely 
deploy Virtual Software Packages to client computers on managed computers on your 
network. You can also remotely control the state of the Virtual Software Packages on 
client computers and view reports about Virtual Software Packages deployment and 
usage. Software Virtualization Solution is also integrated with Altiris® Inventory 
Solution™ and the Altiris® Software Delivery Solution™ Software Portal. For 
information, see Using Software Virtualization Solution in a Notification Server 
Environment (page 72).

Using Software Virtualization Solution in an Altiris® Deployment 
Solution™ Environment

Using Software Virtualization Solution and Deployment Solution, you can remotely 
deploy Virtual Software Packages to client computers on your network. For information, 
see Using Software Virtualization with Altiris® Deployment Solution™ (page 118).

How does Software Virtualization Solution Affect my Network?
What Demands does SVS place on the Physical Network? (page 18)

Are there Minimum Bandwidths Requirements for Deploying Virtualized Applications 
to Off-site Users? (page 19)

Are there Requirements for Microsoft Active Directory to Support SVS? (page 19)

Does SVS Use any of the Native Microsoft MSI Methods for “Application 
distribution”? (page 19)

How does SVS Work with Recovery Solution and other Backup Products? (page 19)

What Demands does SVS place on the Physical 
Network?
SVS does not add any unique demands on a network. When used in a Notification Server 
environment, the only demand is during the initial package delivery, the same as with 
Software Delivery Solution. All of the same tools available in Software Delivery Solution 
(multicasting, bandwidth throttling, automatic resume of failed transfer, and so on) are 
available to you to maximize bandwidth usage. However, Software Delivery Solution is 
not required (both products use the same back-end architecture for management).
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Are there Minimum Bandwidths Requirements for 
Deploying Virtualized Applications to Off-site 
Users? 
There is no “recommended” minimum bandwidth, although the Altiris framework 
provides tools to help make distributions to remote users easier (see What Demands 
does SVS place on the Physical Network?), including the ability to require a minimum 
bandwidth before attempting a download. VSPs can be deployed on Package Servers 
and Deployment Servers.

Are there Requirements for Microsoft Active 
Directory to Support SVS? 
There are no additional configuration requirements for SVS to work with Microsoft Active 
Directory. At this time, there is no specific interaction between Active Directory and SVS.

Does SVS Use any of the Native Microsoft MSI 
Methods for “Application distribution”? 
You can use “Live Capture” to deploy an .MSI using Software Delivery Solution. When 
doing this, a capture is started on the client before the install runs and ended after the 
install ends. The result is a virtualized application. This allows customers to leverage 
their existing .MSI libraries but results in dissimilar instances of the VSP on every 
workstation. 

However, for greater manageability, we recommend performing a single installation in a 
controlled environment, then optimizing and testing a standardized VSP to deploy to 
every client computer. 

How does SVS Work with Recovery Solution and 
other Backup Products?
If a client computer is protected using Recovery Solution or a similar backup application, 
the SVS redirection area shows in the Recovery Solution name space, and can be part of 
snapshots. Layers can be successfully restored through a Full System Recovery or full 
Rollback. Using these methods, the entire redirection area with accompanying registry 
settings are restored and will function correctly. 

However, full functionality is not possible if only files from the redirection are restored. 
For this reason, a simple restore of files from the redirected folder (Example: C:\fslrdr, 
C:\fslrdr\1) should not be done through Recovery Solution. Instead, the whole system 
needs to be restored together.

How does Software Virtualization Solution Affect Client 
Computers?

How does SVS Affect Application Performance? (page 20)

Are there Special Requirements for Running Virtualized Applications? (page 20)

How SVS Affects Local Drive Space Usage (page 20)

How SVS Affects Drive Space Usage Statistics in Windows (page 20)
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How does SVS Affect Application Performance?
Virtualized applications have nearly no performance degradation over applications 
installed locally. There is a 2-3% measurable overhead, primarily on file opens. However, 
once files are open, there is almost no overhead at all.

Are there Special Requirements for Running 
Virtualized Applications?
SVS requires no additional hardware requirements. You only need to install the Software 
Virtualization Agent. The SVS File System Filter Driver is around 160 KB and consumes 
less than 1 MB of working memory under heavy load.

How SVS Affects Local Drive Space Usage 
Currently, the hidden redirection area that layers are stored on is only on the client 
computer’s C drive. The C drive must have enough free space to accommodate all 
desired layers.

How SVS Affects Drive Space Usage Statistics in 
Windows
The hidden redirection area that layers are stored on is on the client computer’s C drive. 
The drive space usage statistics for the C drive will reflect these files.

However, if the layer is pointing to the D drive, the files are still physically on the C drive, 
not the D drive. Example: Suppose you have a layer for an application like MS Office 
that is pointing to a D drive (used as an “apps drive”). Drive space usage statistics for 
the D drive will not reflect the files, but statistics for the C drive will.

Software Virtualization Solution Limitations
The following are current limitations of Software Virtualization Solution:

What Things Cannot or Should not be Virtualized? (page 20)

SVS File System Filter Driver and Running Windows in Safe Mode (page 20)

What Things Cannot or Should not be Virtualized?
Some applications do not work well virtualized at this time. These include drivers, virus 
checkers, file encryption products, OS patches, computer management agents, and 
applications that have dedicated drivers (Example: client firewalls).

You cannot encrypt files that are stored in a data layer. If you encrypt a folder that is in 
the layer, the folder is moved to the base. When files are moved to that folder, you get 
an error that the files cannot be encrypted and you can move them into the layer only as 
unencrypted files. 

SVS File System Filter Driver and Running Windows in Safe 
Mode

The SVS File System Filter Driver is not loaded when a computer is booted into Windows 
Safe Mode. Any diagnostic or recovery utilities that could be usable in safe mode to 
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diagnose and recover a system should not be included in a layer. These utilities will not 
be available if they have been added to the system through a layer, thus possibly 
making it too late to recover after they become necessary. 

Software Virtualization Solution Glossary
SVS File System Filter Driver

The SVS File System Filter Driver is a Windows NT technology that manages the data 
flow between applications and the operating system.

Software Virtualization Agent

The agent software on a client computer containing the SVS File System Filter Driver 
that manages Virtual Software Packages.

Software Virtualization Solution Admin (SVS Admin)

The Software Virtualization Solution Windows-based tool used to create, edit, and 
export Virtual Software Layers. You can also use SVSAdmin to manually manage layers 
on a client computer.

SVS redirection area

When a VSP is imported onto a computer, the contents of the VSP (both files and 
registry settings) are placed in a folder in a special protected SVS area on the hard dive, 
referred to as the SVS redirection area. The SVS redirection area is a folder named 
C:\fslrdr.

Virtual Software Package

The generic term for all the files that makes an application work, including applications 
and data, files and registry settings. A Virtual Software Package can be in one of two 
formats: a “Virtual Software Layer” or a “Virtual Software Archive” file.

Virtual Software Layer

A Virtual Software Layer is the base collection of files and registry definitions and data 
for a Virtual Software Package.

When a layer is imported to a client computer, the data from the layer is placed in a 
hidden SVS redirection area. When a layer is activated, the contents of the layer are 
overlaid over the base file system and registry and the contents of the layer appear as if 
it had been installed.

There are two kinds of layers: Application layers and Data layers.

Layers contain two sublayers: the Read-only sublayer and the Writeable sublayer.

Virtual Software Archive (VSA)

The portable version of a Virtual Software Package. A Virtual Software Archive contains 
the compressed data from a layer in a single portable file that can be deployed and 
imported on client computers.
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Virtual Software Package resource object

The deployed payload when deploying VSA files in a Notification Server environment. 
These are similar to Software Delivery Packages used with Software Delivery Solution.
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Part II
Using Software Virtualization Solution Packages 
and Client Tools

This part includes the following chapters that explain how to create and use Virtual 
Software Layers in a stand-alone environment.

Getting Started with Virtual Software Layers and Archive Files (page 24)

Performing Virtual Software Layer Tasks (page 32)

Advanced Virtual Software Layer Topics (page 42)



 

Chapter 3
Getting Started with Virtual Software Layers and 
Archive Files

The Getting Started tasks guide you through the basic setup, configuration, and use of 
Virtual Software Layers and Archive Files. Each task has a procedure and, in many 
cases, exercises to illustrate the steps of the procedure. 

Prerequisites for Getting Started tasks

A client computer running one of the following operating systems:

Windows 2000 Professional SP4 or higher

Windows 2000 Advanced Server SP4 or higher

Windows XP Professional SP1 or higher

Windows Server 2003 or higher

Access to application setup files that you want to create layers for.

Getting started tasks

1. Configuring a Base Computer (page 24)

2. Installing the Software Virtualization Agent and Admin Tool on a Base Computer 
(page 25)

3. Creating a Virtual Software Layer using SVS Admin (page 25)

4. Testing, Activating, and Deactivating Layers (page 27)

5. Modifying a Layer (page 28)

6. Resetting a Layer (page 30)

7. Exporting a Layer to a Virtual Software Archive File (page 30)

8. Importing VSA Files (page 31)

9. Using Virtual Software Archive Files (page 31)

For a complete list of tasks you can perform with layers, see Performing Virtual Software 
Layer Tasks (page 32) and Advanced Virtual Software Layer Topics (page 42).

Exercise Scenario

The exercises below will guide you through the process of creating and using a layer for 
Mozilla Firefox. If you want to follow the exercise, download the Firefox setup file 
(Firefox Setup ver.exe) from http://www.mozilla.org/products/firefox/.

Configuring a Base Computer
A base computer is the computer that you will capture application and data files on. The 
installed application and data files and settings will be captured into Virtual Software 
Layers.
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The base computer should have a clean installation of your Windows operating system 
and little else. This computer should not have background processes or programs 
running that will get captured into your layers. We recommend that your base computer 
not be running antivirus or other computer management programs, and if possible, not 
have an active Internet connection. 

We suggest creating layers on a virtual computer. This lets you easily disconnect the 
computer from the network and reset the computer after each capture so you have a 
clean operating system.

Exercise
For this exercise, you will want to use a computer that does not currently have Firefox 
installed on it, but has Internet Explorer.

Installing the Software Virtualization Agent and 
Admin Tool on a Base Computer

The Software Virtualization Agent can be installed with the Software Virtualization 
Admin tool (SVS Admin) and used to create and manage Virtual Software Layers and 
Virtual Software Archive Files. You will install the Software Virtualization Agent and SVS 
Admin on your base computer.

You can access the setup file from anywhere. Because we recommend that you not have 
an active Internet connection, the setup file should be local.

For client computer prerequisites, see Prerequisites for Getting Started tasks (page 24) 
and Software Virtualization Solution Security (page 69).

Installing SVS Agent and Admin

To install the Software Virtualization Agent and Admin tool (SVS 
Admin) 

1. On your base computer, run the agent setup file Software_Virtualization_Agent.msi.

2. Enter the product key and click Next.

3. From the Select Features screen, select the Software Virtualization Admin Tool 
checkbox.

4. Complete the setup wizard.

5. Restart the computer.

Creating a Virtual Software Layer using SVS Admin
After you have installed SVS Admin, you can create Virtual Software Layers. In order to 
create a layer for an application, you will “capture” the installation of the application. All 
installed files, registry settings, and application settings will be captured and stored in 
the layer.
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To create a Virtual Software Layer

In the following steps, you will create a new layer for Mozilla Firefox.

1. On the base computer, make sure you have access to the setup files for the 
application you will be creating a layer for. Example: Firefox Setup ver.exe.

2. On the base computer, open the SVS Admin tool by clicking the SVS Admin icon on 
the desktop.

3. Select File > Create New Layer.

4. Choose Install application and click Next.

5. Name the layer. Example: Firefox 1_5.

The maximum name length is 64 characters.

Caution
Layers must not have the following characters in the layer name: & < > “ ' .

6. Click Next.

7. Select the capture method.

For this exercise, choose Single program capture.

For information on capture options, see Creating Virtual Software Layers (page 32).

8. Click Browse.

9. Navigate to the setup file. Exercise: Firefox Setup ver_exe.

10. Click Next.

11. Click Finish.

The animated capture icon (yellow lightning) appears in the system tray. The icon is 
animated (top to bottom) signifying that you are capturing.

12. Follow any dialogs to install the application.

In most cases, when the application installation is complete, the capture is 
automatically ended and the layer is listed in SVS Admin.

However, in the Firefox exercise, when the installation is complete, you have the 
option to Launch Mozilla Firefox now. If this option is selected when you click 
Finish, Firefox will load and because it was loaded by the installer, SVS will still be 
in capture mode. If this option is cleared when you click Finish, the capture mode 
will terminate with the installer and the capture process is finished.

13. For the exercise, keep the Launch Mozilla Firefox now option selected and click 
Finish.

The first time you launch Firefox, you are given configuration options. Since you are 
still in capture mode, these configuration settings will be stored in the Read-only 
sublayer. 

If you were not in capture mode when you launched Firefox for the first time, but 
simply launched it through the layer, these settings would be stored in the Writeable 
sublayer. (For information about sublayers, see Layer Architecture (page 13).)

14. Select an import option and click Next.

15. Select the Home Page options and click Next.
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Because you are still in capture mode, this Home Page setting will be stored in the 
Read-only sublayer.

16. Select default browser settings.

The default browser setting will determine if Firefox is the default browser when the 
Firefox layer is active. This setting will only apply when the Firefox layer is active. 
Example: You may have Internet Explorer previously set as the default browser. If 
you make Firefox the default browser, then when the Firefox layer is active, Firefox 
will be the default browser. When the Firefox layer is not active, Internet Explorer 
will be the default browser. 

For this exercise, make Firefox the default browser by clicking Yes.

Firefox is now installed and running and you are still in capture mode. You can either 
continue to manually configure Firefox or you can end the SVS capture.

17. For this exercise, terminate the capture now by closing Firefox.

When Firefox is closed, the capture is terminated, the capture icon disappears from 
the system tray, and the Firefox layer is now listed in SVS Admin. 

Information about modifying layers is provided in Modifying a Layer (page 28).

Testing Layers

After you have created a layer, you can test it to make sure it functions properly. To test 
a layer, you can manually activate and use the layer on a computer. For information, see 
Testing, Activating, and Deactivating Layers on page 27.

To test portability, you should test the layer on another computer. This ensures that 
everything needed to run the program was captured into the layer.

Testing, Activating, and Deactivating Layers
When a layer is created, it is activated by default. When a layer is activated, that means 
that all the contents of the layer are visible.

To activate or deactivate a layer

1. In SVS Admin, do one of the following:

Highlight a layer and click File.

Right-click a layer.

2. Click either Activate or Deactivate.

When a layer is active, the layer name is displayed in bold type.

Using the SVS Admin tool, you can activate and deactivate layers and test that the layer 
is functioning properly.

Example: When Mozilla Firefox is installed, by default a shortcut to the application 
appears on the Windows Desktop. When the layer is activated, the shortcut is visible. A 
Short cut is also displayed in the Start > Programs list.

When a layer is deactivated, the application components are hidden. The shortcut will 
not be displayed on the Windows Desktop or Start > Programs list, and the files are 
not viewable in the file system.
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To test the active Firefox layer

1. Launch Firefox:

Click the Mozilla Firefox shortcut icon on the desktop. 

Select Start > Programs > Mozilla Firefox > Mozilla Firefox.

2. Verify that the application files are viewable in the file system:

a. Open Windows Explorer.

b. Browse to C:\Program Files\Mozilla Firefox.

3. Verify that Firefox is the default browser:

a. Open Windows Explorer.

b. Select Tools > Folder Options.

c. Click the File Types tab.

d. Scroll down and click the HTML extension.

The default application for HTML files is listed by “Opens with:”. If you made 
Firefox the default browser, it will be listed.

To deactivate and test the deactivated Firefox layer

1. In SVS Admin, right-click the Firefox layer and click Deactivate Layer.

2. Verify that the following shortcuts are no longer virtualized:

The Mozilla Firefox shortcut icon on the desktop. 

The Start > Programs > Mozilla Firefox folder.

3. Verify that the application files are hidden in the file system:

a. Open Windows Explorer.

b. Browse to C:\Program Files.

The \Mozilla Firefox folder should no longer be virtualized.

4. Verify that Firefox is not the default browser:

a. Open Windows Explorer.

b. Select Tools > Folder Options.

c. Click the File Types tab.

d. Scroll down and click the HTML extension.

The default application for HTML files is listed by “Opens with:”. Firefox will not be 
listed. The default program before you installed Firefox will be listed.

Modifying a Layer
You can modify layers to add or remove files, settings, and so on. Example: You can add 
bookmarks to or change the default security settings in the Firefox layer.

When you modify a layer, you can make changes to the Read-only sublayer or the 
Writeable sublayer. (For information about sublayers, see Layer Architecture on 
page 13.) Changes to the Read-only sublayer are permanent, whereas changes to the 
Writeable sublayer will be deleted if the layer is ever reset.
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Making Layer Changes in the Read-only Sublayer (page 29)

Making Layer Changes in the Writeable Sublayer (page 29)

Making Layer Changes in the Read-only Sublayer
To make permanent changes to the Read-only sublayer, open the layer in capture mode. 
This is the same mode used when creating the layer.

To modify a layer, it must be deactivated. 

To modify a layer using capture mode

1. In SVS Admin, deactivate all layers.

2. Select File > Update Existing Layer.

3. Select the layer you want to update. Example: Firefox 1_5.

4. Click Next.

5. Select Single program capture and click Next.

6. Click Browse.

7. Navigate to the setup file. Example: C:\windows\system32\cmd.exe.

8. Click Next.

9. Click Finish.

The layer is activated and the animated capture icon appears in the system tray 
signifying that you are in capture mode.

10. Make the changes you want to make.

For the Firefox exercise, do the following:

a. Launch Firefox.

b. In the address bar, enter the following URL:

www.altiris.com/juice/svs

c. Select Tools > Options.

d. Click General.

e. Click Use Current Page.

This sets www.altiris.com/juice/svs as the default home page.

f. Click OK.

11. After you have configured the application, right-click the capture icon in the system 
tray and choose Stop Capture.

The new default home page is stored in the permanent Read-only sublayer.

For more information about updating application layers, see Updating Layers (page 38)

Making Layer Changes in the Writeable Sublayer
To make changes to the Writeable sublayer, simply activate the layer, and make any 
desired changes.

For the Firefox exercise, do the following:
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1. Launch Firefox.

2. Select Tools > Options.

3. Click Content.

4. Clear the Enable Java and Enable Javescript checkboxes.

5. Click OK.

The Java settings are stored in the Writeable sublayer and will be deleted if the layer is 
reset. 

Note
You can also edit the Writeable sublayer through the SVS Admin.

Resetting a Layer
When a layer is created, the data captured is stored in a Read-only sublayer (see Layer 
Architecture on page 13). If a user makes any changes to the application/data, that data 
is stored in a Writeable sublayer. You can reset the layer, which deletes all the data 
added by the user (writeable data) and maintains the original read-only data.

For information, see Resetting Layers (page 37).

To manually reset the Firefox layer

1. In SVS Admin, right-click the Firefox layer.

2. Click Reset Layer and click Yes.

This deletes all data in the Writeable sublayer.

For the Firefox exercise, when you launch Firefox, the Java settings are reset to 
enabled.

Exporting a Layer to a Virtual Software Archive File
After you have created and configured a layer, you can export it to a portable Virtual 
Software Archive file (VSA). You can then share the VSA file or include it in a Notification 
Server Virtual Software Package to deploy to network users using Software 
Virtualization Solution in Notification Server.

To export a layer to an archive VSA file

1. In SVS Admin, right-click the layer and click Deactivate Layer.

2. If this layer is to be distributed to other users, you may now want to Reset the layer 
to remove existing user-specific information.

3. Right-click the layer and click Export Layer.

4. Select a filename and location to save the file. Example: C:\archives\Firefox1.5.vsa.

5. Click OK.

All the contents of the layer are exported to the VSA file.
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Importing VSA Files

Using SVS Admin, you can import an existing VSA file to make the layer available 
through the SVS Agent. 

To manually import a VSA archive file

1. Copy an existing VSA file to a place you can access it from.

2. In SVS Admin, select File > Import from Layer.

3. Browse to the VSA file you want to import.

4. Click Open.

The layer appears in SVS Admin.

Accessing Sample VSA Files

The Altiris Juice Web page contains sample VSA files that you can download and import.

1. Open a Web browser to www.altiris.com/juice/svs.

2. From the links on the left, click Topic Cloud.

3. Under the Topic Cloud, click sample applications.

4. Click a sample application.

5. Click the download link.

6. Select Save to disk and click OK.

Using Virtual Software Archive Files
You can use Virtual Software Archive files in several different ways. For information, see 
the following topics:

Additional stand-alone tasks 
you can perform with layers

See Performing Virtual Software Layer Tasks 
(page 32) and Advanced Virtual Software Layer Topics 
(page 42).

Deploying VSA files using 
Notification Server

See Using Software Virtualization Solution in a 
Notification Server Environment (page 72).

Deploying VSA files using 
Deployment Solution

See Using Software Virtualization with Altiris® 
Deployment Solution™ (page 118).

General usage information See Software Virtualization Solution Usage Scenarios 
(page 16).
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Chapter 4
Performing Virtual Software Layer Tasks

Virtual Software Layers are created and managed using the Software Virtualization 
Solution Admin (SVS Admin) tool. For instructions on installing SVS Admin, see Getting 
Started with Virtual Software Layers and Archive Files (page 24).

This section describes how to perform the following Virtual Software Layer tasks:

Creating Virtual Software Layers (page 32)

Activating and Deactivating Layers (page 37)

Resetting Layers (page 37)

Updating Layers (page 38)

Deleting Layers (page 39)

Exporting and Importing Layers (page 40)

Starting a Layer Automatically (page 41)

Viewing Layer Properties (page 41)

Renaming a Layer (page 41)

For information on advanced layer tasks, see Advanced Virtual Software Layer Topics 
(page 42).

Creating Virtual Software Layers 
You can create three different kinds of Virtual Software Layers:

The following topics explain the following tasks:

Creating Virtual Application Layers (page 33)

Creating and Using Virtual Data Layers (page 34)

Creating and Using Empty Layers (page 36)

You can create layers using SVS Admin or command-line parameters. For information 
about command-line parameters, see Using SVSCMD Command-line Parameters 
(page 51).

Application layer All installed files, registry settings, and application settings will 
be captured and stored in the layer.

Data layer Data files are captured and stored in a dedicated data layer.

Empty layer An Empty layer is an application layer without an application 
installed into it. Nothing is initially captured but you can edit the 
layer manually. There is no functional difference between 
creating an application layer by capture versus creating an 
empty layer and then updating it by capturing an application 
install.
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Caution
Layers must not have the following characters in the layer name: & < > “ ' .

Creating Virtual Application Layers
To create a layer for an application, you will “capture” the installation of the application. 
All installed files, registry settings, and application settings will be captured and stored 
in the layer.

To create a Virtual Software Layer

1. On the base computer, make sure you have access to the setup files for the 
application you will be creating a layer for. 

2. On the base computer, open the SVS Admin tool by clicking the SVS Admin icon on 
the desktop.

3. Select File > Create New Layer.

4. Choose Install application and click Next.

5. Name the layer. Exercise: Firefox 1_0_7.

The maximum name length is 64 characters.

Caution
Layers must not have the following characters in the layer name: & < > “ ' .

6. Click Next.

7. Select the capture method.

There are two methods of capturing an application:

Single 
program 
capture

Only the changes during the installation of a specified program 
will be captured. Using this method, you select an application 
setup file. The capture automatically begins when the setup is 
started and the capture is automatically ended when the setup 
is completed. During this capture, only changes made for the 
selected application will be captured. Any other activity on the 
computer will be ignored. This is the preferred method of 
creating virtual software layers.

If an application is installed through a packaging tool, such as 
Wise or InstallShield, SVS tracks the initial package process as 
well as any client instances of msiexec.exe. All client instances 
of msiexec.exe and accompanying service instances are 
captured as long as they are running, whether or not the 
original packaged .EXE terminates. See To create a layer using 
Single Program Capture (page 34).

Caution
All processes that were started by the application (Example: a 
system tray application) must be exited before the capture 
process will complete.
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To create a layer using Single Program Capture

1. Choose Single program capture.

2. Click Browse.

3. Navigate to the setup file. Example: Firefox Setup 1.0.7.exe.

4. Click Next.

5. Click Finish.

6. The animated capture icon (yellow lightning) appears in the system tray. The icon is 
animated (top to bottom) signifying that you are capturing.

7. Follow any dialogs to install the application.

8. When the application is complete, the capture is automatically ended and the layer 
is listed in SVS Admin.

To create a layer using Global Capture

1. Select the Global capture method.

2. Click Next.

3. Click Finish.

The animated capture icon (yellow lightning) appears in the system tray. The icon is 
animated (top to bottom) signifying that you are capturing.

4. Install the application. Example: Run Firefox Setup 1.0.7.exe.

5. (Optional) After the installation is complete, open the application and set any 
application preferences that you want to be default for your users. For example, you 
can set a default home page or custom security settings.

6. After you have configured the application, exit the application.

7. Right-click the capture icon in the system tray and choose Stop Capture.

8. The layer is now listed in SVS Admin.

Testing Layers

After you have created a layer, you can test it to make sure it functions properly. To test 
a layer, you can manually activate and use the layer on a computer. For more 
information, see Testing, Activating, and Deactivating Layers (page 27).

Creating and Using Virtual Data Layers
Not only can you create virtual applications, but you can create virtual data layers. Using 
data layers, you can capture data files and redirect them to a layer rather than having 
them written to an application layer or the core file system. You can use one or more 
data layers for each user. 

Global 
capture

All changes made to the computer during the capture process 
will be saved into the layer. This option is useful in capturing 
default application settings, shortcuts, or application updates 
after an installation is complete. You can also combine multiple 
applications into a single layer. See To create a layer using 
Global Capture (page 34).
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Uses for Data Layers

How Data Layers Work

Creating Data Layers

Uses for Data Layers
Data layers can be useful in the following ways:

Storing data from virtual applications

Data layers can be useful in managing data generated from virtual applications. 

Any data generated by a virtual application will, by default, be saved within the 
Writeable sublayer of that application layer. This data will be lost if the layer is reset. By 
using a data layer, the data is stored separately and will not be deleted due to a layer 
reset. For general information about managing data with SVS, see Managing Data Within 
Layers (page 42).

Providing a single, portable data store

Data layers can also be useful for having a single source of user data files that can easily 
be exported to a VSA and moved or copied to a different computer. Example: You could 
create a data layer to store a company’s product catalog and price list that is updated 
monthly. Each month, this layer could be exported to a VSA and distributed to the sales 
force to ensure they have the current files. The layer could then be deleted at the end of 
each month to ensure that obsolete data is not circulated or available.

How Data Layers Work
Using data layers, you can capture all files of a certain file extension and/or all files 
saved to a specified directory.

Using file extensions

You can create a data layer that will capture all files with a specified extension.

Example: You have a layer for Microsoft Office. You can create a data layer and configure 
that layer to capture all .DOC and .XLS file types. When a user saves a file from the 
Office layer, all .DOC and .XLS files are stored into the data layer rather than the Office 
layer. Those files are then protected if the Office layer is ever reset.

Files with the specified extension will be captured even if they are generated outside a 
layer.

Using directories

You can also create a data layer for a specific directory. You can select whether or not to 
include sub-directories. Example: You can create a data layer that captures all files 
written to the My Documents folder. Any file saved to My Documents or one of it’s 
subfolders would be redirected to the data layer.

New and existing files

When you create or deploy a data layer, there will usually be existing data files on the 
computer with either the specified file extension or in the specified paths. Those files are 
not automatically captured into the layer. Instead, as soon as the files are modified, they 
are then redirected to the layer and removed from the core file system.
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Creating Data Layers

To create a data layer

1. On the base computer, open the SVS Admin tool.

2. Select File > Create Layer.

3. Click Data Layer and click Next.

4. Name the layer.

5. Select the capture method, file extension, or directory.

Note
When creating a data layer, you can configure either file extensions or a directory. 
To use both, you must edit the layer after it is created. For information, see Viewing 
and Editing Layer Properties (page 45).

To specify file extensions, do the following:

a. Select File extension(s).

b. Enter the file extensions. 

Multiple extensions can be used by separating them with a semi-colon.

Example: doc;xls

Do not include the wildcard asterisk, as it will be interpreted as part of the 
file extension. 

Example: do not use *.doc;*.xls

To specify a directory, do the following:

a. Select Directory.

b. Click Browse and select the directory.

By default, sub-directories will also be included. To not include 
subdirectories, clear the Include subdirectories checkbox.

6. Click Next.

7. Click Finish.

The layer appears in SVS Admin. 

8. To activate the layer, right-click it and click Activate Layer.

Creating and Using Empty Layers
An empty layer has nothing captured into it. You can manually edit the empty layer later. 
One useful purpose is creating an application layer for a program that does not have an 
installer. You would create the empty layer and then use the Advanced Layer Editor to 
add the files that are needed for the application.

To create an empty layer

1. On the base computer, open the SVS Admin tool by clicking the SVS Admin icon on 
the desktop.

2. Select File > Create Layer.
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3. Choose Empty Layer and click Next.

4. Name the layer and click Next.

5. Click Finish.

For information on manually adding files to layers, see Viewing and Editing Layer 
Properties (page 45).

Activating and Deactivating Layers
When a layer is created, it is activated by default. When a layer is activated, that means 
that all the contents of the layer are visible. When a layer is deactivated, the contents of 
the layer are hidden.

Activating and deactivating layers can be performed remotely or locally. Example: If you 
are using Software Virtualization Solution in a Notification Server or Deployment 
Solution environment, a helpdesk worker can remotely send a command to activate/
deactivate an application. If a computer is not connected to the network, a user can 
manually activate/deactivate the layer.

For information about remotely activating and deactivating layers, see Using SVSCMD 
Command-line Parameters (page 51).

For information about manually activating and deactivating layers, see Testing, 
Activating, and Deactivating Layers (page 27).

Quick Link

Deactivating Layers with Services Running

Deactivating Layers with Services Running
You cannot deactivate a layer while a process is running from that layer. If you try to 
deactivate a layer with a process running, you will get a message stating that a process 
is running and asks you if you want to stop the service. If you click Yes, the service will 
be stopped and the layer will be deactivated.

The service PID (Process Identifier) is also displayed. You can use this PID to look up the 
process in Task Manager. To see PIDs in Task Manager, it will need to be configured to 
show the PID. 

To see PIDs in Task Manager

1. Open Windows Task Manager.

2. Click the Processes tab.

3. Select View > Select Columns.

4. Select the PID (Process Identifier) checkbox.

5. Click OK.

Resetting Layers
When a layer is created, the data captured is stored in a Read-only sublayer (see Layer 
Architecture on page 13). If a user makes any changes to the application/data, that data 
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is stored in a Writeable sublayer. You can reset the layer, which deletes all the data 
added by the user (writeable data) and maintains the original read-only data.

Resetting the layer is useful if an application becomes damaged. You can reset the layer 
without having to uninstall/re-install the application. This is also useful in maintaining 
standard versions and configurations of applications across your network.

Another advantage to resetting a layer is that is does not damage other applications 
installed on the computer.

Using the Advanced Layer Editor, you can view files and settings that are contained in 
the Read-only and Writeable sublayers. For information, see Viewing and Editing Layer 
Properties (page 45).

Resets can be performed remotely or locally. Example: If you are using Software 
Virtualization Solution in a Notification Server or Deployment Solution environment, a 
helpdesk worker can remotely send a reset command to reset a damaged application. If 
a computer is not connected to the network, a user can manually reset the layer.

To manually reset a layer

1. In SVS Admin, do one of the following:

Highlight a layer and click File.

Right-click a layer.

2. Click Reset Layer.

For information about remotely resetting layers, see Using SVSCMD Command-line 
Parameters (page 51).

Caution
Any data generated by a virtual application will, by default, be saved within the 
Writeable sublayer of that application layer. This data will be lost if the application layer 
is reset. For general information about managing data with SVS, see Managing Data 
Within Layers (page 42).

Updating Layers
You can update layers by modifying the contents of an existing layer. When you update a 
layer, the capture mode is turned on, and any changes made on the computer are 
captured. For example, you could open an application and change default settings.

When you update a layer using capture mode, the changes are made to the Read-only 
sublayer making them permanent (see Layer Architecture on page 13).

Example: You may have a layer for Mozilla Firefox and you may want to change some 
application preferences that you want to be default for your users.

You have the same capture options as when you created the layer—you can use either 
Global capture or Single program capture.

Updating Layers Using Global Capture (page 39)

Updating Layers Using Single Program Capture (page 39)

You can also use a command-line parameter to update a layer. For information, see 
Using SVSCMD Command-line Parameters (page 51).
Altiris Software Virtualization Solution Reference 38



 

Note
You cannot update a layer if any layers are active on the computer. 

Updating Layers Using Global Capture

To update a layer using Global capture

Follow the instructions provided at Modifying a Layer (page 28).

Updating Layers Using Single Program Capture
If you want to update a virtual application using Single program capture, there is 
currently not a way to select the application process directly because the executable is in 
the layer and the layer is not active. 

Example: You may want to update a layer for Firefox by launching it using Single 
program capture, letting it perform its auto updates, then automatically ending capture. 
There is currently not a way to select the Firefox executable within an inactive layer. 
However, there is a work-around available listed below.

To update a layer using Single program capture

1. On the base computer, open the SVS Admin tool by clicking the SVS Admin icon on 
the desktop.

2. Select File > Update Existing Layer.

3. Select the layer you want to update. Example: Firefox.

4. Click Next.

5. Select Single program capture.

6. Browse to C:\WINDOWS\system32\cmd.exe.

7. Click Next.

8. Click Finish.

This activates the layer and opens the command prompt window.

9. In the DOS window, run the application file. Example: C:\Program Files\Mozilla 
Firefox\Firefox.exe.

10. Make the changes you want to make. 

11. After you have configured the application, exit the application.

12. Exit the command prompt window.

13. The capture process terminates.

Deleting Layers
You can delete an existing layer. 

Deleting a layer deletes all data in the layer. Ensure that any files you want are moved 
out of the layer before deleting it.
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To delete a layer

1. In SVS Admin, right-click the layer and click Delete Layer.

2. Confirm that you want to delete the layer.

You can also use a command-line parameter to delete a layer. For information, see Using 
SVSCMD Command-line Parameters (page 51).

Exporting and Importing Layers
Layers can be exported to a Virtual Software Archive (VSA file) so that they can be 
shared. VSA files can be stored on a network share, e-mailed, or deployed to client 
computers on your network using Software Virtualization Solution or Deployment 
Solution.

You can manually import an existing VSA using SVS Admin so that you can edit, update, 
or use the layer as a stand-alone layer.

Exporting Layers to VSA Files (page 40)

Importing VSA Files (page 40)

Exporting Layers to VSA Files

To export a layer to an archive VSA file

1. In SVS Admin, right-click the layer and click Deactivate Layer.

2. Right-click the layer and choose Export Layer.

3. Save the file. Example: C:\archives\AcrobatReader7.vsa.

4. Click OK.

Importing VSA Files
You can import an existing VSA file to make the layer available through the SVS Agent.

Activating and deactivating layers can be performed remotely or locally. Example: If you 
are using Software Virtualization Solution in a Notification Server or Deployment 
Solution environment, a helpdesk worker can remotely send a command to import a 
VSA file. You can also manually activate/deactivate a layer.

For information about remotely importing layers, see Using SVSCMD Command-line 
Parameters (page 51).

You can also manually import a VSA file using SVS Admin.

To manually import a VSA archive file

1. In SVS Admin, select File > Import from Layer.

2. Browse to the VSA file you want to import.

3. Click Open.

The layer appears in SVS Admin.
Altiris Software Virtualization Solution Reference 40



 

Starting a Layer Automatically

You can configure a layer to start (activate) automatically on system boot or not start 
automatically on system boot when the layer is deployed to a client computer.

Note
Layers should be set to start automatically on client computers that do not have the SVS 
Admin console installed; otherwise users may not be able to access the data in the 
layers.

To set a layer to start automatically

1. In SVS Admin, do one of the following:

Highlight a layer and click File.

Right-click a layer.

2. Click Start Layer Automatically.

If a checkmark appears next to the option, Start Layer Automatically is enabled.

You can also use a command-line parameter to set a layer to start automatically. For 
information, see Using SVSCMD Command-line Parameters (page 51).

Viewing Layer Properties
You can view layer properties that will display useful information about the layer, such as 
the type of layer, the number of files in the layer, and the disk space used by the layer.

To view layer properties

1. In SVS Admin, right-click a layer and click Layer Properties.

Renaming a Layer
You can rename a layer, but only when it is deactivated. 

To rename a layer

1. In SVS Admin, select a layer to rename.

2. If the later is activated, deactivate it by selecting File > Deactivate Layer.

3. Select the layer and select Edit > Rename.

4. Type the new name for the layer.

The maximum name length is 64 characters and any characters can be used.

You can also use a command-line parameter to rename a layer. For information, see 
Using SVSCMD Command-line Parameters (page 51).
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Chapter 5
Advanced Virtual Software Layer Topics

This section describes the following advanced Virtual Software Layer topics:

Managing Data Within Layers (page 42)

Viewing and Editing Layer Properties (page 45)

Using SVSCMD Command-line Parameters (page 51)

Using Layer Prioritization (page 57)

Managing Application Updates within Layers (page 64)

Handling Duplicate Services in Multiple Layers on page 65

Software Virtualization Agent Installation (page 65)

Software Virtualization Solution Security

Managing Data Within Layers
Data can be easily preserved or deleted depending on how layers are used.

This section includes the following topics:

Preserving Data (page 42)

Deleting Data (page 44)

Preserving Data
When an application layer is active, all files created or modified by that layer, and that 
are stored on the client computer, are redirected by the SVS File System Filter Driver to 
the layer itself. (If files are stored on a network share, the SVS File System Filter Driver 
does not redirect the file to the layer.) The files redirected to a layer are stored in the 
Writeable sublayer. If a layer is reset, all data in the Writeable sublayer is deleted. In 
many cases, you may want to preserve the files created from a layer. As a result, it is 
important to properly manage the data within a layer so that data that should be 
preserved is not deleted.

Example: If you have a Microsoft Word layer, and from that layer you save a DOC file to 
the client computer’s hard drive, in any folder, that file will be redirected by the SVS File 
System Filter Driver to the Microsoft Word layer. When the layer is active, the file will 
appear to be stored in the destination folder that was selected, but the file is actually 
stored in the SVS redirection area. If the Microsoft Word layer is reset, that DOC file will 
be deleted.

There are three ways to preserve data created through layers:

Layer Exclude Entries (page 43)

Data Layers (page 43)

Non-local Storage (page 44)
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Layer Exclude Entries
You can configure a layer to exclude file types or folder locations so that a file will be not 
be redirected by the SVS File System Filter Driver to the layer, but will instead be saved 
to the core file system.

Example: Suppose you have a layer for Microsoft Word, you can exclude file types .DOC, 
.RTF, .TXT, .HTML, .XML, and so on, so that any data file that is saved by the Word layer 
is excluded from being redirected to the layer. Instead, those files will be saved in the 
core file system. You can also exclude a directory, so that any files saved to that folder 
and it’s subfolders are not redirected.

The disadvantage with using exclude entries is that you have to configure the excludes 
for each layer. For a more global solution, you can use Data Layers (page 43).

To configure exclude entries

Note
To configure exclude entries, the layer must be deactivated.

1. Open SVS Admin.

2. Double-click a deactivated layer.

3. Click the Exclude Entries tab.

4. Under Type, right-click and select New Exclude Entry.

5. Select the entry type, file extension, or directory.

To specify file extensions, do the following:

a. Select File extension(s).

b. Enter the file extension(s). 

You can specify one or more extensions. Multiple extensions can be used by 
separating them with a semi-colon.

Example: doc;xls

Do not include the wildcard asterisk, as it will be interpreted as part of the 
file extension. 

Example: do not use *.doc;*.xls

To specify a directory, do the following:

a. Select Directory.

b. Click Browse and select the directory.

By default, sub-directories will also be included. To not include 
subdirectories, clear the Include subdirectories checkbox.

After an entry has been created, you can modify or delete it by right-clicking the entry 
and clicking Modify or Delete.

Data Layers
You can create a data layer that will capture data files into a dedicated data layer. This is 
useful in storing data files that are created by other layers. Data layers cannot be reset 
so the data files contained in data layers are protected.
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For more information, see Creating and Using Virtual Data Layers (page 34).

Non-local Storage
If you save a file from a layer to a non-local storage device, such as a network share, 
the SVS File System Filter Driver will not redirect the file to the layer.

Deleting Data
This topic describes what happens when you delete files when using layers.

There are two possible outcomes for deleting files while working with layers:

The file is not really deleted, but hidden while the layer is active.

The file is actually deleted.

These different results depend on how the layer is being used when a file is deleted and 
also how the file was deleted.

Note
A file rename can also result in these delete entries being created. Use a layered 
application to rename a file, and you really get a delete entry covering the original file 
(which will still exist), and a new copy of the file under the new name.

When Files are not Deleted, but Hidden

When Files are Actually Deleted

When Files are not Deleted, but Hidden
When a layer is activated, under normal circumstance, files in the layer are visible that 
are not visible when the layer deactivated. The opposite can also occur. Files in the core 
file system may be deleted (hidden) when a layer is activated.

Example: During the capture process of installing Firefox, you create a shortcut for 
Firefox and you also delete a shortcut for Internet Explorer. When the Firefox layer is 
activated, the Firefox shortcut is visible while the Internet Explorer shortcut is not. When 
the Firefox layer is deactivated, the Internet Explorer shortcut is again visible while the 
Firefox shortcut is not.

When a file in the core file system is deleted through a layer, the file is not actually 
deleted, but marked as a delete entry and is hidden while the layer is active.

Delete entries can be viewed through the Advanced Layer Editor. For more information, 
see Viewing and Editing Layer Properties (page 45).

Delete entries can be stored in either the Read-only sublayer or the Writeable sublayer 
depending on the way a layer is being used.

Delete Entries stored in the Read-only sublayer

When in capture mode, all changes made to the file system are stored in the layer’s 
Read-only sublayer. If a file was deleted while in capture mode, the files is not actually 
deleted, but a delete entry is stored in the Read-only sublayer. This would be the case in 
the Internet Explorer shortcut example listed above.
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Delete Entries stored in the Writeable sublayer

When performing tasks through a virtual application all changes made are stored in the 
Writeable sublayer. As a result, if you use a service in a virtual application to delete a file 
in the core file system or the Read-only sublayer, a delete entry is stored in the Read-
only sublayer.

Example: You have a layer for Microsoft Word. From Word, you select File > Save As, 
and a list of files is displayed in the current folder. You can delete an existing file from 
the Save As dialog. If you delete a file that is either in the core file system or in the 
Read-only sublayer, the file is not actually deleted, but a delete entry is stored in the 
Writeable sublayer and the file is hidden.

This occurs because the file deletion was performed by a service running from the layer.

If the layer is reset, the delete entry is deleted and the deleted file would reappear from 
the layer.

Another case of a delete entry being stored in a Writeable sublayer is when a file in the 
Read-only sublayer is deleted by a process running outside of a layer. Example: If while 
a Firefox layer is active, and using Windows Explorer, a Firefox program file in the Read-
only sublayer is deleted, the file is not actually deleted, but hidden and a delete entry is 
stored in the Writeable sublayer. The file will be restored if the layer is reset.

This illustrates one of the benefits of virtualized applications. If a virtualized application 
becomes unusable because required files were deleted, the layer can be reset and all 
original files are restored.

When Files are Actually Deleted
There are cases where files are actually deleted. 

While a layer is active, if you delete a file in a layer’s Writeable sublayer, the file is 
actually deleted from the layer. The files are deleted whether the deleting process is in 
or out of a layer.

Since all files in a data layer are stored in a Writeable sublayer, deletions of files in a 
data layer are permanent.

Note
In the case where a file is not really deleted but moved to the Recycle bin, the file is still 
in the layer, under an folder node representing the recycle bin. The file is not actually 
deleted until the recycle bin is emptied while the layer is active.

While a layer is active, if you delete a file that is not in a layer through a process that is 
not in a layer, SVS is not involved and the file is deleted.

Viewing and Editing Layer Properties
Using SVS Admin, you can view and edit the contents of layers. In order to view or edit 
layer properties, the layer must be deactivated. 

To open the Advanced Layer Editor

1. Open SVS Admin.

2. Double-click a deactivated layer

This opens the Advanced Layer Editor.
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This topic explains how to do the following tasks:

View and Modify Files Contained in a Layer (page 46)

View and Edit Registry Settings Contained in a Layer (page 47)

View Variables used in a Layer (page 47)

Configure Exclude Entries of a Layer (page 50)

View Delete Entries of a Layer (Application layers only) (page 51)

Configure Data Capture Properties of a Layer (Data layers only) (page 51)

View and Modify Files Contained in a Layer
In the Advanced Layer Editor under the Files tab, you can view all the folders and files 
that are contained in the layer. The Read-only and Writeable sublayers are separated in 
two different nodes (Read-only) and (Writeable). By default, the (Read-only) node is 
displayed on top. You can either scroll down or collapse the (Read-only) node to see the 
(Writeable) files.

The folder names that are displayed are the variablized names. For information about 
variablization, see View Variables used in a Layer (page 47). To see what folders the 
variablized folders represent, click the Variables tab.

Viewing Layer Files

Modifying Layer Files

Viewing Layer Files
To view the files in a layer, click a folder in the left pane and the files in the folder are 
displayed in the right pane.

For example, you can view the following files in a Mozilla Firefox application layer.

To see the main program executable files, click layer name (Read-only) > System 
> [Programfiles]. In this case, [PROGRAMFILES] represents C:\Program Files.

To see the Firefox bookmarks file that was captured with the layer, click 
layer name (Read-only) > User-specific > USER_TEMPLATE > [APPDATA] > 
Mozilla > Firefox > Profiles > xxx (where xxx is a Firefox controlled name. In this 
case, [APPDATA] represents C:\Documents and Settings\username\Application Data.

If you have added a bookmark to the Firefox layer, the updated bookmarks file is written 
to the Writeable sublayer and can be found under layer name (Writeable) > User-
specific > USER_SID > [APPDATA] > Mozilla > Firefox > Profiles > xxx.

If you reset a layer, you can see that all the files in the Writeable node are deleted.

Modifying Layer Files
In a layer, you can create new folders and copy, rename, and delete folders. You can 
also copy, rename, and delete files. This is useful in modifying a layer without having to 
recapture it.

Not only can you copy files within a layer, you can copy files and folders into a layer from 
outside the layer and vice-versa. You can either use copy/paste or drag and drop.
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Caution

Using the Advanced Layer Editor, you can’t overwrite files. To update a file, delete the 
original and copy or move the new file. 

When using drag and drop, you can only move files into the layer, not copy. To copy, use 
copy and paste, rather than drag and drop.

You can’t modify the actual file in a layer. Example: You can’t open and edit an .INI file. 
You must activate the layer and then edit the file.

View and Edit Registry Settings Contained in a Layer
In the Advanced Layer Editor under the Registry tab, you can view or modify all the 
registry settings that are contained in the layer. The Read-only and Writeable sublayers 
are separated in two different nodes (Read-only) and (Writeable). 

To edit registry settings you follow the same process as you would with Microsoft 
Registry Editor. However, you must keep in mind that you have both the Read-only and 
Writeable sublayers to maintain.

Note
SVS does not store data in the virtual HKEY_CLASSES_ROOT key. Instead it stores it in 
its real location under either HKEY_CURRENT_USER\Software\Classes or 
HKEY_LOCAL_MACHINE\Software\Classes. At runtime, Windows reads the SVS data for 
active layers from these locations and properly renders HKEY_CLASSES_ROOT.

View Variables used in a Layer
Many applications have specific environment settings for file paths, paths in registry 
values, .MSI paths, and so forth. To make VSPs portable across computers, many 
application settings and data layer properties are variablized by Software Virtualization 
Solution.

For instance, SVS uses common system variables to substitute for well-known locations 
on a Microsoft Windows based installation, such as WINDIR as a substitute for the 
“Windows” folder. This provides seamless compatibility with systems that may not be 
using the standard folder structure, such as systems that have moved their “My 
Documents” folder, or that have renamed operating system folders.

Example: If you have a VSP for My Documents, that may be on the C drive on one 
computer but on a D drive on a different computer. Variablization allows the data layer 
to work correctly on both computers.

Variable Types

Variable List and Description

Examples of items that are variablized include:

File Paths

Paths in Registry Values

Short Paths

.MSI Paths

Data Layer Specifications
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Exclude Entries

Delete List Entries

You can use the layer editor to see the variables used for each layer and what values 
they have in them. 

To open the layer editor

1. Open SVS Admin.

2. Double-click a deactivated layer.

3. Click the Variables tab.

Variable Types
There are two types of variables: SYSTEM and USER.

These are set as environment variables when layers are active

SVS uses the following tags to denote variables:

[_B_] = Beginning tag

[_E_] = Ending tag

[_CS_] = Convert to short path

[_MSI_] = Convert to .MSI path

When converting a path to its variablized form, the longest matching variablized path is 
used. Example: C:\Documents and Settings\User\Desktop\1.txt would convert to 
DESKTOP\1.txt not USERPROFILE\Desktop\1.txt

Variable List and Description
The following is a list of default variables that the system uses.

System variables System variables are static and loaded at boot time. Example:

WINDIR = C:\Windows

SYSTEMDRIVE = C:

User variables User variables are per user and are loaded when the user logs 
on. Example:

DESKTOP = C:\Documents and Settings\User\Desktop

USERPROFILE = C:\Documents and Settings\User

System Variables

Variable Description Example

SYSTEMDRIVE The drive letter of the 
volume that contains 
the Windows directory 
that the system 
booted.

C:
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WINDIR The Windows 
directory that was 
booted.

C:\Windows

PROFILESDIRECTORY The directory that 
contains local user 
profile information.

C:\Documents and Settings

ALLUSERSPROFILE The directory that 
contains the All Users 
profile.

C:\Documents and Settings\All Users

DEFAULTUSERPROFILE The directory that 
contains the Default 
User profile.

C:\Documents and Settings\Default User

COMMONADMINTOOLS C:\Documents and Settings\All Users\Start 
Menu\Programs\Administrative Tools

COMMONAPPDATA C:\Documents and Settings\All Users\Application Data

COMMONDESKTOP C:\Documents and Settings\All Users\Desktop

COMMONDOCUMENTS C:\Documents and Settings\All Users\Documents

COMMONFAVORITES C:\Documents and Settings\All Users\Favorites

COMMONPROGRAMS Folder that contains 
common items that 
show up under Start 
Menu / All Programs

C:\Documents and Settings\All Users\Start 
Menu\Programs

COMMONSTARTMENU C:\Documents and Settings\All Users\Start Menu

COMMONSTARTUP C:\Documents and Settings\All Users\Start 
Menu\Programs\Startup

COMMONTEMPLATES C:\Documents and Settings\All Users\Templates

COMMONMUSIC C:\Documents and Settings\All Users\Documents\My 
Music

COMMONPICTURES C:\Documents and Settings\All Users\Documents\My 
Pictures

COMMONVIDEO C:\Documents and Settings\All Users\Documents\My 
Videos

PROGRAMFILES C:\Program Files

MEDIAPATH C:\WINDOWS\Media

COMMONFILES C:\Program Files\Common Files

MSSHAREDTOOLS C:\Program Files\Common Files\Microsoft Shared

User Specific Variables

Variable Description Example

ADMINTOOLS C:\Documents and Settings\user\Start 
Menu\Programs\Administrative Tools

APPDATA C:\Documents and Settings\user\Application Data

CACHE C:\Documents and Settings\user\Local 
Settings\Temporary Internet Files

System Variables (Continued)
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Configure Exclude Entries of a Layer
By default, data generated by a layer is stored in the layer. You can exclude data from 
being saved in a layer so that it will be stored in the base file system. For information, 
see Managing Data Within Layers (page 42).

CDBURNING C:\Documents and Settings\user\Local 
Settings\Application Data\Microsoft\CD Burning

COOKIES C:\Documents and Settings\user\Cookies

DESKTOP C:\Documents and Settings\user\Desktop

FAVORITES C:\Documents and Settings\user\Favorites

FONTS C:\WINDOWS\Fonts

HISTORY C:\Documents and Settings\user\Local Settings\History

LOCALAPPDATA C:\Documents and Settings\user\Local 
Settings\Application Data

LOCALSETTINGS C:\Documents and Settings\user\Local Settings

MYMUSIC C:\Documents and Settings\user\My Documents\My 
Music

MYPICTURES C:\Documents and Settings\user\My Documents\My 
Pictures

MYVIDEO C:\Documents and Settings\user\My Documents\My 
Videos

NETHOOD C:\Documents and Settings\user\NetHood

PERSONAL C:\Documents and Settings\user\My Documents

PRINTHOOD C:\Documents and Settings\user\PrintHood

PROGRAMS Folder that contains 
user specific items 
that show up under 
Start Menu / All 
Programs

 C:\Documents and Settings\user\Start Menu\Programs

RECENT C:\Documents and Settings\user\Recent

SENDTO C:\Documents and Settings\user\SendTo

STARTMENU C:\Documents and Settings\user\Start Menu

STARTUP Folder that contains 
user specific items to 
be run on system 
startup

C:\Documents and Settings\user\Start 
Menu\Programs\Startup

TEMPLATES C:\Documents and 
Settings\user\Templa
tes

TEMP Folder where 
temporary files can 
be created

C:\DOCUME~1\user\LOCALS~1\Temp

USERPROFILE Location of the 
current user's profile

C:\Documents and Settings\user

User Specific Variables (Continued)
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View Delete Entries of a Layer (Application layers only)

When using a layer, a user may delete a file from the layer. The file is not actually 
deleted, but only hidden. This is because if a file is from the Read-only sublayer, it needs 
to exist if the layer is reset.

Example: A user is using an application layer for Firefox and that user deletes a file. That 
file is part of the Read-only sublayer and needs to be maintained. It is hidden from the 
user but is displayed in the Delete Entries.

The Delete Entries tab only shows file delete entries. There is also an equivalent to these 
entries in the registry (they work the same, but are stored and viewed differently). In 
the registry, a delete entry shows up in the normal registry editor tab and looks like 
“~FSL~KeyOrValueName”.

Configure Data Capture Properties of a Layer (Data layers 
only)

The data capture properties are configured the same as exclude entries, except for 
everything is referred to as a data capture item. The dialogs look the same and behave 
the same as for configuring exclude items.

Using SVSCMD Command-line Parameters
When working with VSA files outside of the SVS Admin tool, you perform actions on VSA 
files using the SVSCMD executable with command-line parameters. SVSCMD.exe is part 
of the Software Virtualization Solution Agent installation. The following sections describe 
how to use command-line parameters.

SVSCMD Usage Scenarios (page 51)

SVSCMD Parameters, Flags, and Examples (page 53)

SVSCMD Usage Scenarios
The section explains how SVSCMD is used in the following usage scenarios:

Notification Server Environment (page 51)

Deployment Solution Environment (page 52)

Stand-alone Environment (page 52)

Notification Server Environment
When Software Virtualization Solution is used in a Notification Server environment, the 
Software Virtualization Agent (SVSCMSD) is deployed to managed computers. You 
create a Virtual Software Package resource for each VSA file with the desired action and 
state. Each Virtual Software Package resource specifies the command-line to be used on 
the VSA file. 

Example: You may create a package that will activate a Mozilla Firefox VSA. In the 
Virtual Software Package resource properties, you would specify the command-line 
execution properties as:

SVSCMD.exe [LayerName|GUID] “Activate”
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You also create a Virtual Software Task to deploy the package with the command-line 
parameters to client computers. When the client computer receives the package, it runs 
SVSCMD and activates the specified layer.

Note
The Virtual Software Wizard is provided to easily create packages and tasks with the 
appropriate command-line statements. For information, see Using Software 
Virtualization Solution in a Notification Server Environment (page 72).

Deployment Solution Environment
When Software Virtualization Solution is used in a Deployment Server environment, the 
Software Virtualization Agent (SVSCMSD) is deployed to AClient-enabled computers. 
You create a Deployment Server job for each VSA file with the desired action and state. 
Each job specifies the command-line to be used on the VSA file. 

Example: You may to deploy a Mozilla Firefox VSA and have it imported and 
automatically activated. In the job, you would add a “Run Script” and specify the 
command-line execution properties as:

SVSCMD.exe [LayerName|GUID] I -p [PathToExe] Auto -Y

For information about Deployment Server jobs, see Using Software Virtualization 
Solution in a Deployment Solution Environment (page 117).

Stand-alone Environment
If you have the Software Virtualization Agent installed on a computer, but not the 
SVSAdmin tool, you can use SVSCMD to perform layer tasks. Example: You can create 
new layers or import existing VSA files. You can activate, deactivate, or reset layers.

Example: If you want to create a new layer for Mozilla Firefox, you would do the 
following:

1. Have access to the Firefox setup file.

2. From the command-line type:

SVSCMD.EXE “Firefox” CAPTURE -P “C:\Firefox Setup 1.0.7.exe”

Where “Firefox” is the name of the layer, CAPTURE tells SVSCMD to create a layer, 
and -P “C:\Firefox Setup 1.0.7.exe” is the path to the setup file.

Note
If the layer name or filename has a space, you can put them in quotes. Example: 
“C:\Firefox Setup 1.0.7”. Otherwise, they do not require quotes.

When the layer is created, it is activated automatically.

Layers are stored in a protected area on the file system and the files are not 
viewable.

3. To view a list of layers on the computer, type:

SVSCMD.EXE ENUM

4. To view the status and properties of a layer, type:

SVSCMD.EXE “Firefox” p
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SVSCMD Parameters, Flags, and Examples

SVSCMD has many parameters that can be used. There are also flags that can be used 
with specific parameters.

The syntax for using SVSCMD is the following:

SVSCMD [LayerGUID|LayerName] {<command> [flags]} [...n]

The following tables list and describe the available command-line parameters, flags, and 
provides examples:

Valid Parameters: (page 54)

Valid Parameter Options (Flags): (page 55)

Command-line Examples: (page 56)
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Valid Parameters:

Parameter Associated 
Flags

Description

A[CTIVATE] Activates the layer.

D[EACTIVATE] [-F] Deactivates the layer.

R[ESET] [-F] Resets the layer.

I[MPORT] [-P|-F] Imports a VSA file.

E[XPORT] [-P] Exports the layer to a VSA file.

DEL[ETE] [-F] Deletes the layer.

REN[AME] -NAME Renames the layer.

C[APTURE] [-P|-S|-E] Creates a new layer by capturing changes.

Note
You cannot perform a capture if any other layer is active on that 
computer. 

Note
The lighting bolt icon only appears if capturing through SVS Admin.

AUTO[ACTIVATE] [-Y|-N] Sets a layer to start automatically.

P[ROPERTIES] Displays properties for the layer, such as its name, state, type, priority, 
version, guid, last activated time, create time, and last reset time.

CREATE Creates an empty layer.

VER[SION] Displays SVS version information.

ENUM[ERATELAYERS]  [-V] Enumerates all layers on the computer.

SEND[INVENTORY] Sends updated inventory to Notification Server.

H[ELP] Displays this help screen.

CHECKKEY -K Checks for a valid product serial number. This tells you if your key is 
good and provides information about it.

SETKEY -K Updates the product serial number. You can use this to manually set a 
key.

PRIORITY [-T|-L|-R] Sets the priority of a layer. See Using Layer Prioritization (page 57).

EXEC[FROMLAYER] [-PID|-PATH] Executes a process as a part of the layer. This make a certain process 
look like it is running form a layer. This can be useful in the following 
ways:

Suppose you are running an audit tool, and you want that tool to 
see the computer from the perspective of the layer. You can run 
SVSCMD “LayerName” EXEC [path to the executable] and then any 
process that is run will have the same priority as if run from the 
layer.

You can run a process that will make changes to the file system or 
registry and those changes will be saved in the layer, and not in 
the base.
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Valid Parameter Options (Flags):

Flag Description

-F[ORCE] Force command when it might otherwise fail (forces an overwrite during import, or 
applications closed if running from layer).

-S[TART] Start capture.

-E[ND] End capture.

-P[ATH] <path> Full filename path to VSA file or program to capture. If the filename has a space, you can put 
the path and filename in quotes. For example, “C:\Firefox Setup 1.0.7”.

-Y[ES] Turns the option on.

-N[O] Turns the option off.

-V[ERBOSE] Display verbose output from the command.

-NAME <name> Specifies the new name.

-K[EY] <serial> Specifies the product serial number.

-L[EVEL] <level> Priority of the layer.

-T[YPE] <type> Priority type (NORMAL or HKCR).

-R[ESET] Resets the priority to default.

-PID <PID> Specifies the Pid of the process that needs to be executed as a part of layer.
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Command-line Examples:

Command-line examples Result

SVSCMD.EXE “Sample App” CREATE Creates an empty layer named 
Sample App.

SVSCMD.EXE “Sample App” A Activates the Sample App layer.

SVSCMD.EXE “Sample App” D -F Forces a deactivation of the 
Sample App layer.

SVSCMD.EXE “Sample App” DEL -F Forces a deletion of the Sample 
App layer.

SVSCMD.EXE 4db31efa-9163-45de-b33f-bb4737aa022c RESET -F Forces a reset of the layer with 
the specified GUID.

SVSCMD.EXE “Sample App” CAPTURE -START Creates a new layer named 
Sample App by capturing 
changes. The capturing is 
started and is active.

SVSCMD.EXE “Sample App” CAPTURE -E Ends the capture of changes to 
the layer named Sample App. 
(Used after the CAPTURE -
START command).

SVSCMD.EXE “Sample App” CAPTURE -P C:\WINDOWS\system32\notepad.exe Creates a layer for the specified 
application Notepad.exe.

SVSCMD.EXE MyData Layer P Displays the properties for the 
layer named MyDataLayer.

SVSCMD.EXE 4db31efa-9163-45de-b33f-bb4737aa022c AUTO -Y Sets the layer with the 
specified GUID to start 
automatically.

SVSCMD.EXE I -P C:\VSP\Layer.vsa -F Forces the import the specified 
VSA file.

SVSCMD.EXE “Sample App” EXPORT -PATH “C:\My Packages\Sample App.vsa” Exports the layer named 
Sample App to the specified 
VSA file.

SVSCMD.EXE VER Displays the current version of 
the Software Virtualization 
Agent files.

SVSCMD.EXE ENUM Lists all existing layers.

SVSCMD.EXE SEND Sends inventory information to 
Notification Server.

SVSCMD.EXE HELP Displays the help for SVSCMD.

SVSCMD.EXE CHECKKEY -KEY xxxxx-xxxxx-xxxxx-xxxxx Lets you know if the key you 
pass on the command line is a 
valid key.

SVSCMD.EXE SETKEY -KEY xxxxx-xxxxx-xxxxx-xxxxx Sets the product key.

SVSCMD.EXE “Sample App” PRIORITY -T NORMAL -L 34.231

(For information about priorities, see Using Layer Prioritization on page 57).

Sets the priority for the Sample 
App layer to type Normal with a 
priority value of 34.231.
Altiris Software Virtualization Solution Reference 56



 

Using Layer Prioritization
There may be times when you need to control which layer has precedence in the event 
that different layers have conflicting contents. Prioritization lets you control the priority 
of those conflicting contents. 

Example: If you open an HTML file, Windows Explorer will go to the registry and 
determine which application is registered to open that file. When using Software 
Virtualization Solution, you may have different application layers that are associated 
with HTML files, such as Internet Explorer, Firefox, or Opera. You can control which layer 
(which Web browser application) gets the priority and opens the file.

In another example, you may have different versions of the same .DLL file in different 
layers. Prioritization lets you control which version of the .DLL file has the highest 
priority and is therefore used. 

How Prioritization Works

Normal Layer Priorities

HKEY_CLASSES_ROOT Priorities

Configuring Layer Priorities

How Prioritization Works
When a request is made, Software Virtualization Agent does the following:

1. Builds a list of all the active layers

2. Assigns a priority to each active layers based on the following:

The type of request that is being made (Normal or HKEY_CLASSES_ROOT)

Where is the request coming from

3. Orders and searches the layers based on priority

Request Types

Prioritization is based on two types of requests:

SVSCMD.EXE “Sample App” PRIORITY -L 34.231 Sets the priority for the Sample 
App layer with a priority value 
of 34.231.

SVSCMD.EXE “Sample App” PRIORITY -T HKCR -L 34.231 Sets the priority for the Sample 
App layer to type HKCR with a 
priority value of 34.231.

SVSCMD.EXE “Sample App” PRIORITY -R Resets the priority of the 
Sample App layer.

SVSCMD.EXE “Sample App” PRIORITY -T NORMAL -R Resets the priority of the 
Sample App layer and sets the 
type to normal.

SVSCMD.EXE “Sample App” PRIORITY -T HKCR -R Resets the priority of the 
Sample App layer and sets the 
type to HKCR.

Command-line examples Result
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The request being made to the normal file system

The request being made to HKEY_CLASSES_ROOT

Each type of request has a different set of priorities. 

The following sections describe how to use prioritization:

Normal Layer Priorities (page 58)

HKEY_CLASSES_ROOT Priorities (page 60)

Configuring Layer Priorities (page 62)

Normal Layer Priorities
Normal layer priorities are the priorities assigned to layers for all files and registry data 
except HKEY_CLASSES_ROOT data.

Example: Opening a certain data file

After the request is identified as a normal layer priority type request, the priority is 
based on the location of the file or registry entry. Each priority is given a priority value. 
The lower the value number, the higher the priority. 

Note
When changing the default properties, you should only change the .5 value of the layer.

Conflicting Files within the Same Layer Priority

Normal Layer Priorities

Default 
Priority 
Values

Priorities Description

45.5 (Highest) Data Layer Data layer are layers that contain data files. Data layers are given 
highest priority because only one copy of the file should be available 
for reading and writing. Users expect the same file every time they 
open a data file. (This is not necessarily the case for an executable or 
.DLL file.)

55.5 Owner Layer If the executable that is used to start a process comes from an active 
layer, that layer is the “owner layer” for the process. Also, child 
processes have the same “owner layer” as their parent process, 
regardless of where their executable is located.

This way, an application will use files in its own layer before using a file 
in the base or a different application layer.

Example: If you have an active layer for Microsoft Office, and if the 
request comes from an application in that Microsoft Office layer, the 
files in that layer are given “base owner” priority.
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Default Layer Priorities Example #1

You have an active data layer as well as active layers for Microsoft Office and Firefox and 
you are running Office from that active layer. If Office makes a request for 
EEFONTS.DLL, the Software Virtualization Agent will do the following:

1. Build a list of all active layers and the base.

2. Assign the following priorities:

45.5 assigned to the data layer (highest priority)

55.5 assigned to the Microsoft Office layer that is the “owner layer”

75.5 assigned to the base

85.5 assigned to the Firefox normal layer

Because the request came from a layer, there is no base owner priority.

3. Searches for the .DLL based on the priorities assigned:

a. Searches first in the active data layer. If it finds the .DLL in the data layer, it will 
use that version.

65.5 Base Owner The base is the normal folders and files on the computer outside of any 
layers. If the process comes from an application running from the 
base, a pseudo layer is created for the base and given this priority. In 
this case, the base functions as an owner layer. 

Example: Suppose you have active layers for Microsoft Office and 
Firefox, but Adobe Acrobat is installed in the base and not in a layer. 
When Acrobat makes a request, the files in the base file system are 
given “base owner” priority. 

75.5 Base The base is the normal folders and files on the computer outside of any 
layers. If the process is not running from the base, the base is given 
this priority. 

The difference between “base” and the “base owner” is whether or not 
the requesting application is running from the base. If the application is 
running from the base, then it is considered the “base owner.” If the 
requesting application is running from a layer, then the base files are 
given “base” priority.

Example: Suppose you have active layers for Microsoft Office and 
Firefox. If a request comes from an application in the Microsoft Office 
layer, any files in the base (outside of all active layers) would be given 
“base” priority.

85.5 (Lowest) Normal Normal priority is given to files in any other active layer that the 
application is not running from. For example, if you have two layers, 
one for Microsoft Office and one for Firefox, and if the request comes 
from the Microsoft Office layer, files in the Firefox layer are given 
“normal” (lowest) priority.

Normal Layer Priorities

Default 
Priority 
Values

Priorities Description
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b. If the .DLL is not found in an active data layer, it will look in the layer that Office 

was launched from, which is considered the owner layer. If it finds the .DLL in 
the owner layer, it use that version.

c. If the .DLL is not found in the owner layer, it will look in the base. If it finds the 
.DLL in the base, it will use that version.

d. If the .DLL is not found in the base, it will look in other active layers. If it finds 
the .DLL in a different active layer, it will use that version.

4. In this example, the EEFONTS.DLL is in the Microsoft Office layer the request is 
directed there.

Default Layer Priorities Example #2

You have an active data layer as well as an active layer for Microsoft Office but you are 
running Adobe Acrobat from the base. If Acrobat makes a request for ACRORD32.DLL, 
the Software Virtualization Agent will do the following:

1. Build a list of all active layers and the base.

2. Assign the following priorities:

45.5 assigned to the data layer

65.5 assigned to the base layer that is the “base owner”

85.5 assigned to the Microsoft normal layer

Because the request came from the base, a “base owner” layer is created and 
there is no base priority.

3. Searches for the .DLL based on the priorities assigned:

a. Searches first in the active data layer. If it finds the .DLL in the data layer, it will 
use that version.

b. If the .DLL is not found in a data layer, it will look in the layer that Acrobat was 
launched from. In this case, Acrobat was launched from the base, which is then 
considered the base owner layer. If it finds the .DLL in the base owner layer, it 
will use that version. (In this case, this no “owner layer” or “base” priorities.)

c. If the .DLL is not found in the base owner, it will look in other active layers. If it 
finds the .DLL in an active layer, it will use that version.

4. In this example, the .DLL is in the owner base layer the request is directed there.

Conflicting Files within the Same Layer Priority
You may have a situation where you have conflicting files within the same priority. For 
example, files in data layers are always given the highest priority. What if you have two 
different active data layers and each one has a different version of a file that is 
requested by an application? You can set a different priority for each data layer. 

For information on how to resolve priority conflicts, see Configuring Layer Priorities 
(page 62).

HKEY_CLASSES_ROOT Priorities
This is the priority assigned to a layer when looking at HKEY_CLASSES_ROOT data. 
HKEY_CLASSES_ROOT priorities are handled differently because this is typically what 
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applications use to register what files they use and they are not tied to the rest of the 
layer priorities.

By using HKEY_CLASSES_ROOT priorities, you can control when an application registers 
to handle certain extensions in HKEY_CLASSES_ROOT and you can order separately 
than the file order of the application.

Example: Which application will be opened to handle a given file type.

For example, you may have two active layers for two different Web browser applications. 
Both of them are registered to handle opened HTML files. You can use priorities to 
determine which layer you want to open the HTML files.

Note
The HKEY_CLASSES_ROOT key is a virtual key that Windows creates by combining the 
data from HKEY_CURRENT_USER\Software\Classes and 
HKEY_LOCAL_MACHINE\Software\Classes. When there is a conflict in this data, 
preference is given to the data contained in HKEY_CURRENT_USER\Software\Classes. 

SVS does not store data in the virtual HKEY_CLASSES_ROOT key. Instead it stores it in 
its real location under either HKEY_CURRENT_USER\Software\Classes or 
HKEY_LOCAL_MACHINE\Software\Classes. At runtime, Windows reads the SVS data for 
active layers from these locations and properly renders HKEY_CLASSES_ROOT.

Conflicting Settings within the Same HKEY_CLASSES_ROOT Priority

After the request is identified as a HKEY_CLASSES_ROOT type request, the priority is 
based on where the location of the file or registry entry is located.

Because there are no registry entries in a data layer, data layers are not considered for 
HKEY_CLASSES_ROOT priorities.

HKEY_CLASSES_ROOT Priorities

Default 
Priority

Location Description

55.5 Highest Owner Layer If the executable that is used to start a process comes from a layer, 
that layer is the “owner layer” for the process. Also, child processes 
have the same “owner layer” as their parent process, regardless of 
where their executable is located.

Example: Suppose you have an active layer for Firefox and you have 
Internet Explorer installed in the base and both are registered in 
HKEY_CLASSES_ROOT to be the default application for HTML files, then 
when the Firefox layer is active, Firefox will be given priority and will be 
used when an HTML file is opened.

65.5 Normal Normal priority is given to HKEY_CLASSES_ROOT settings in any other 
active layer than the application is not running from. 

75.5 Base Owner The base is the normal HKEY_CLASSES_ROOT settings on the 
computer outside of any layers. If the process is running from the 
base, the settings in the base are given this priority.

85.5 Lowest Base The base is the normal HKEY_CLASSES_ROOT settings on the 
computer outside of any layers. If the process is not running from the 
base, the settings in the base are given this priority.
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HKEY_CLASSES_ROOT Priorities Example #1

You have an active layer for Firefox but also have Internet Explorer installed on the 
base. If you open an HTML file, the Software Virtualization Agent will do the following:

1. Build a list of all active layers and the base.

2. Assign the following priorities:

65.5 assigned to the Firefox layer that is the “owner layer”

85.5 assigned to the base

3. In this example, Firefox has the highest priority; therefore, it is launched.

Conflicting Settings within the Same 
HKEY_CLASSES_ROOT Priority
You may have a situation where you have conflicting settings within the same priority. 
For example, what if you have two different active layers and each one is registered in 
HKEY_CLASSES_ROOT to handle HTML files? You can set a different priority for each 
layer. 

For information on how to resolve priority conflicts, see Configuring Layer Priorities 
(page 62).

Configuring Layer Priorities
You may have a situation where you have conflicting files within the same priority. For 
example, for general layer priorities, files in data layers are always given the highest 
priority. What if you have two different active data layers and each one has a different 
version of a file that is requested by an application? You can set a different priority for 
each data layer. 

Or what if you have two different active layers and each one is registered in 
HKEY_CLASSES_ROOT to handle HTML files? You can set a different priority for each 
layer. 

Conflicting Normal Priorities Example #1

You have two active data layers and you are running Microsoft Word from the base. If 
Word makes a request for CUSTOM.DIC (the custom spell checking dictionary), it will do 
the following:

1. Build a list of all active layers and the base.

2. Assign the following priorities:

45.5 assigned to the “data layer A”

45.5 assigned to the “data layer B”

65.5 assigned to the base layer that is the “base owner”

3. Searches for the file based on the priorities assigned:

a. Searches first in the active data layers. 

Suppose it finds two different versions of the same CUSTOM.DIC in two different 
active data layers. By default, it will not know which file to use.

You can configure “data layer A” to be priority 45.2 and “data layer B” to be 
priority 45.3.
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b. It will look in the data layer with the highest priority (if different), which in this 

case is “data layer A”, and will use the file in that layer.

Caution
If the two data layers have the same priority, such as 45.5, then the priority is 
undeterminable and which file is used cannot be guaranteed.

Conflicting HKEY_CLASSES_ROOT Priorities Example #2

You have two active layers for different Web browsers, Firefox and Opera. If you open an 
HTML file, it will do the following:

1. Build a list of all active layers and the base.

2. Assign the following priorities:

65.5 assigned to the Firefox layer

65.5 assigned to the Opera layer

85.5 is assigned to the base

3. Determines which application to launch.

By default, because both Firefox and Opera have the same priority, it will not know 
application to launch.

If you wanted to Firefox to always have priority of Opera, you can configure the 
Firefox layer to be priority 65.3 and Opera would keep the default priority 65.5.

4. In this example, because the Firefox label has the higher priority, Firefox will be 
launched instead of Opera.

Note
If the two layers have the same priority, such as 65.5, then the priority is 
undeterminable and which file or registry entry is used cannot be guaranteed.

To set layer priorities

You can set the priorities for a layer using command-line parameters with SVSCMD.EXE.

Note
Use caution when changing the priorities of layers. When setting a priority value, you 
can specify any numeric value. However, we recommend that you only change the 
values to the right of the decimal. If you change the values to the left of the decimal, 
you will change the default priorities and may cause problems when new layer types are 
created in the future. Example: If you have two layers that have a default priority of 
65.5, you can change one to 65.3, giving it a higher priority than the other layer, but still 
maintaining the general class of priority.

For general information about SVSCMD.EXE, see Using SVSCMD Command-line 
Parameters (page 51).

1. On a computer where you have the agent installed, open a DOS window (Start > 
Run > CMD > OK).

2. From the DOS prompt, Type SVSCMD.EXE “LayerName” PRIORITY [-T|-L|-R] 

-T[YPE] <type> = Priority type (NORMAL or HKCR).

-L[EVEL] <Level> = Priority of the layer.
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-R[ESET] = Resets the priority to default.

The following table list examples changing layer priorities.

Managing Application Updates within Layers
A common use of Software Virtualization Solution is to have layers for application that 
you commonly use. What if you want to update the application in a layer? For example, 
suppose you have a layer for Microsoft Office, but an update or patch is released for 
Office that you want to add to your Office layer.

It is possible to update the application within a layer; however, we recommend that 
rather than updating an application layer that you create a new layer that contains both 
the application and the update, and then remove the old layer and use the new one.

There are a couple of reasons for this:

If you update the application in a layer, the changes are captured into the Writeable 
sublayer. If you ever reset the layer, those changes are deleted (see Layer 
Architecture on page 13). So if you apply a security patch to a layer, but then later 
reset the layer, the patch is deleted.

By patching individual layers, you lose the consistency of managing which users are 
using which versions of applications. For example, if you run and .MSI repair on 
different computers, different changes may be made and captured in the layer.

If you do want to update an application within a layer, do the following:

1. Make sure that the .MSI for the application is in the layer (this will be the case by 
default).

2. In SVS Admin, select File > Update Existing Layer.

3. Highlight the layer you want to update and click Next.

4. Select Single program capture and click Next.

5. Click Browse.

6. Navigate to the setup file.

7. Click Next.

8. Click Finish.

This puts you in capture mode.

SVSCMD.EXE “Sample App” PRIORITY -T NORMAL -L 
34.231

Sets the priority for the Sample App layer to type 
Normal with a priority value of 34.231.

SVSCMD.EXE “Sample App” PRIORITY -L 34.231 Sets the priority for the Sample App layer with a 
priority value of 34.231.

SVSCMD.EXE “Sample App” PRIORITY -T HKCR -L 34.231 Sets the priority for the Sample App layer to type 
HKCR with a priority value of 34.231.

SVSCMD.EXE “Sample App” PRIORITY -R Resets the priority of the Sample App layer.

SVSCMD.EXE “Sample App” PRIORITY -T NORMAL -R Resets the priority of the Sample App layer and 
sets the type to normal.

SVSCMD.EXE “Sample App” PRIORITY -T HKCR -R Resets the priority of the Sample App layer and 
sets the type to HKCR.
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9. Update the .MSI.

10. Right-click the capture icon in the system tray and choose Stop Capture.

If this is a layer that you have deployed on your network, you will need to re-export it to 
a VSA file and redistribute to client computers.

Handling Duplicate Services in Multiple Layers
You may have a situation where a service is run from the base or from a layer, and then 
the same service is launched through a different layer. Software Virtualization Solution 
uses reference counts to properly control the creation, starting, stopping, and deletion 
of services with the Service Control Manager. If you deactivate the layer running a 
service, the first instance of the service continues to run. The reference count 
information is stored under HKLM\SYSTEM\Altiris\FSL\Services.

Software Virtualization Agent Installation
The following sections provide information on installation, upgrading, and maintenance 
of the Software Virtualization Agent.

Installer Basics

Automating Installation

Upgrades and Repairs

Troubleshooting Failed Installs

Installer Basics
The SVS Agent installer is a Windows Installer package and therefore includes many 
features common to all Windows Installer packages. Some of the more common options 
are documentation in this section

The SVS Agent package installs a number of components on the system, some 
optionally. The components installed and corresponding files are shown in the following 
table. The paths shown are the defaults on a Windows XP English computer, so adjust 
them appropriately for the systems you are working with.

Driver C:\Windows\system32\drivers\fslx.sys

Library C:\Windows\system32\fsllib32.dll

WMI Provider C:\Program Files\Altiris\Software Virtualization 
Agent\AltirisVSProvider.dll

C:\Program Files\Altiris\Software Virtualization 
Agent\AltirisVSProvider.mof

Command-line Utility C:\Program Files\Altiris\Software Virtualization 
Agent\svscmd.exe
Altiris Software Virtualization Solution Reference 65



 

In addition to installing these files on the hard drive, the installer also creates the file 
redirection area at C:\fslrdr. This is where files that are contained in virtual layers are 
stored. There is a corresponding area of the registry where registry entries for the 
virtual layers are stored. The installer creates this area at 
HKEY_LOCAL_MACHINE\SYSTEM\Altiris\FLS in the registry. A few other registry keys 
are created by the installer as described below.

After creating these resources, the installer has to register some of them on the system. 
It installs the driver in a fashion similar to how a service is installed. (Do not expect to 
see it in your services list, but the registry keys look very similar to a service.) The WMI 
provider is installed using the programmatic equivalent of mofcomp.exe.

The installer sets the security permissions on the File Redirection Area and the Registry 
Redirection Area. For these, administrators and the SYSTEM account are given full 
access.

Finally, Windows Installer itself has some information that it stores about the 
installation. It caches the installer package on the hard drive, creates an entry for the 
agent in Add/Remove Programs, and stores some internal information about the 
components installed.

After the installer has completed, it needs a restart in order for the product to become 
fully usable.

Automating Installation
Now that you have an understanding of the installer package, what do you actually do 
with it? An individual user may double-click the package and run the installer user-
interface to perform the installation. The more advanced user or administrator may want 
to use additional options discussed in this section to customize the installation and 
automate it.

Rolling the agent out to an organization probably means doing a silent install. The 
typical Windows Installer switches are a good start, but not sufficient. At a minimum you 
will need to specify a product key in order to complete the installation. The following 
command-line is an example of this:

Graphical Admin Tool C:\Program Files\Altiris\Software Virtualization 
Agent\svsadmin.exe

C:\Program Files\Altiris\Software Virtualization 
Agent\<Language>\svsadmin_resources.exe

C:\Program Files\Altiris\Software Virtualization 
Agent\fslui.dll

C:\Program Files\Altiris\Software Virtualization 
Agent\<LCID>\fslui_resources.dll 

File Redirection Area C:\fslrdr

Virtual Layer Metadata HKEY_LOCAL_MACHINE\SYSTEM\Altiris\FSL

SVS Product Settings HKEY_LOCAL_MACHINE\SYSTEM\Altiris\SVS

Registry Redirection Area HKEY_LOCAL_MACHINE\SOFTWARE\fslrdr
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msiexec.exe /qn /i Software_Virtualization_Agent.msi 
PRODUCT_KEY=<product-key>

A few other command line parameters can be used to customize the installation, as 
discussed on the following table.

The following command line silently installs the SVS Agent with SVS Admin:

msiexec.exe /i “C:\Software_Virtualization_Agent.msi” /qb- 
PRODUCT_KEY=<product-key> INSTALL_ADMIN=1 

The following command installs the SVS Agent without SVS Admin:

msiexec.exe /i “C:\Software_Virtualization_Agent.msi” /qb- 
PRODUCT_KEY=<product-key> 

Upgrades and Repairs
Upgrades and repairs of a broken installation can be accomplished through standard 
Windows Installer methods. The product key is validated each time the install runs, and 
therefore must be provided. The following commands repair an existing install and 
upgrade the installation respectively.

msiexec.exe /qn /i {7D8DBB7C-1C55-4950-A107-043C164F379A} 
REINSTALL=All REINSTALLMODE=omus PRODUCT_KEY=<product-key>

In this example, we use the Windows Installer product code for the SVS Agent rather 
than pointing to an .MSI file. Since the installer has cached the .MSI file on the computer 
during the initial install, the cached copy can be used for future repair work.

You can use a repair to install SVS Admin at some point after the initial install. This is 
useful if you forget to include the parameter the first time the installer was run.

An upgrade looks almost identical, but provides a slight variation on the switches. In 
order to do an upgrade, you need to provide a new .MSI file. You also need to tell 
Windows Installer to recache the installer package using the new file (the v switch on 
REINSTALLMODE does this).

INSTALL_ADMIN=1 Installs the SVS Admin Tool. 

Note: INSTALL_ADMIN=<any value> will cause 
SVS Admin to be installed. 

REBOOT=ReallySuppress Suppresses restarts and restart prompts. Without 
this switch, the installer will automatically restart 
the computer (assuming that you are doing a 
silent install).

D_FSLRDR=D:\fslrdr Changes the location of the file redirect area. This 
switch is untested.

INSTALLDIR=C:\SVSAgent Changes the install location of the command line 
utility, WMI provider, and Admin tool.

PRODUCT_KEY=<product key> Specifies the product key to be used to install. This 
product key is obtained from Altiris, either when 
you purchase the product or when you download a 
key for free personal use of the product.
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msiexec.exe /qn /i Software_Virtualization_Agent.msi REINSTALL=All 
REINSTALLMODE=vomus PRODUCT_KEY=<product-key>

Troubleshooting Failed Installs
Most failed installs can be successfully completed after a restart and reattempting the 
install. In the event that this does not work, more drastic steps may be necessary.

In the event of an installation failure, you need to create a Windows Installer log in order 
to determine where the failure occurs. You can add the /l*v <logfile> switch to the 
command-line for the installation to generate a log file. Search for “return value 3” 
inside the install log and the few lines above it should have an error message regarding 
the failure.

This error message may tell you exactly what the problem is, such as an invalid product 
key. In other cases, the error message indicates a more involved failure, such as not 
being able to install the driver or WMI provider, or something similar. In those cases, you 
may need to contact Altiris support or do a manual cleanup of the installation.

Manually cleaning up a computer is a simple matter of cleaning up everything the 
installer does. 

To clean up a computer

1. Removing all the files and registry keys listed in the above sections. 

2. Delete the FSLX driver with the following command:

sc.exe delete FSLX

3. Use the following command to remove the local group created for SVS Agent 
security:

net.exe localgroup “Software Virtualization Administrators” /
delete

Removing the WMI Provider is a little more complex. Use the built-in tool named 
wbemtest.exe for this purpose.

To remove the WMI Provider

1. Launch wbemtest.exe.

2. Click the Connect button.

3. Enter the namespace “root\default” and click Connect. 

4. Click the Delete Class button

5. Enter the class name “AltirisVSProv” and follow the prompts to delete the class. For 
completeness, you also need to remove the registry keys created by the WMI 
provider:

HKEY_CLASSES_ROOT\AppID\AltirisVSProvider.DLL

HKEY_CLASSES_ROOT\CLSID\{71D8DF9A-AD2D-44BF-A542-1412F68061D1}

HKEY_CLASSES_ROOT\TypeLib\{888967EF-E75C-4480-992D-
93FDA658F21E}
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6. Clean up the information that Windows Installer caches about the package. The 

easiest way to do this is with a tool called msizap.exe from the Windows Installer 
SDK. The following command removes all Windows Installer data for the SVS Agent:

msizap.exe TW! {7D8DBB7C-1C55-4950-A107-043C164F379A}

Software Virtualization Solution Security
Software Virtualization Solution uses the security systems that are built into the 
Windows NT family of operating systems. Access to Software Virtualization Solution is 
controlled by Access Control Lists (ACLs) in the registry and file system. The ability to 
protect files and directories through ACLs requires the use of the NTFS file system. ACLs 
on virtualized items (registry entries, files, and services) are persisted normally and 
Software Virtualization Solution moves the ACLs when a Virtual Software Package (VSP) 
is exported and imported. This section explains how SVS handles rights on virtual files, 
and the on-disk structure of a VSP. It also explains how to make sure that anti-virus, 
inventory, and other programs function correctly in the virtualized environment.

Rights necessary to administer Software Virtualization Solution

In order for a user to manipulate Software Virtualization Solution or VSP data through 
SVS Admin, that user must be a member of the local Administrators group. There are 
two exceptions: the rights to activate and deactivate can be delegated. Users that have 
Read access to a key named HKLM\System\Altiris\FSL\Rights\Activate are able to 
activate VSPs through SVSCMD or SVS Admin. Users that have Read access to a key 
named HKLM\System\Altiris\FSL\Rights\Deactivate are able to deactivate VSPs through 
SVSCMD or SVS Admin. Users that have rights to change the permissions on these keys 
are able to modify these privileges for other users. While SVS Admin requires a user to 
be an administrator in order to modify VSP data, the user may still be able to browse 
directly into the Software Virtualization Solution redirection areas and modify files and 
registry keys. The user will have the same rights to the files and registry keys in the 
redirection areas as if the application had been installed normally, so this is not a 
problem if the application properly creates ACLs for its files during install.

Anti-virus products and inventory products

Software Virtualization Solution does not affect the run-time protection feature of anti-
virus software. Anti-virus products properly scan virtualized files when they are opened. 
Any measures that the anti-virus product takes against a file that it thinks is infected 
really happen and are not virtualized. However, there is an issue with manual anti-virus 
scanning. If multiple files exist in the base and in one or more VSPs and these overlay 
each other, the scanner only sees and scans one of the files. For example, it might 
enumerate a file named C:\TEST.TXT and scan it, but what it does not see is that a VSP 
may have another version of the same named file. For this reason, we recommend that 
anti-virus scanner programs be configured to be “ignored” by the SVS system. This 
means that when the scanner programs run, they will not see any virtualized files; they 
will only see the file system as it really exists. This guarantees that all files are properly 
scanned. The list of ignored executables can be modified by adding or removing strings 
to HKLM\System\Altiris\FSL\ProgramIgnoreList which is a MULTI-SZ value. The paths 
can be hard-coded (c:\windows\scan.exe) or variablized ([_B_]WINDIR[_E_]\scan.exe). 
If you have other programs, like an inventory product, that you wish to have view the 
file system data without any virtualization, you can add them to this list. You must 
restart in order for these to be in affect.
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VSP User Specific Areas

Data layers and the Writeable sublayer of Application layers are user specific. This 
means that the layer has a unique area for each user that holds information that is 
unique to each user. In the advanced editor in SVS Admin on the File tab, you can see 
that these layers contain some areas that are common for all users, like the Windows 
directory, but areas that are unique for each user exist under a SID directory. The 
directory is named with a string representation of the user's SID. This directory contains 
directories like the user's profile directory and desktop directory. A corresponding area 
exists in the registry. Under HU (HKEY_USERS) you will see a SID directory for each 
user. At runtime, this maps to HKEY_CURRENT_USER.

The Read-only sublayer of an Application layer does not contain unique entries for each 
user. It contains only one copy of user data that is contained in a section called 
USER_TEMPLATE. During the capture process, any user specific data goes into this area. 
When the layer is first used by any user outside of capture mode, a SID directory is 
created for the current user and the contents of the USER_TEMPLATE area are copied. 
The USER_TEMPLATE area in the Read-only sublayer is not used during normal 
operation.

Files, directories, and registry keys are protected with the same rights that protect the 
corresponding objects in the base. Example: When the DESKTOP folder is created in the 
layer, the ACLs are copied from the user's base DESKTOP folder. This assures that only 
the proper users have rights to this folder.

The FAT file system is not secure. It does not support the protecting of files and 
directories with rights. When you build layers that you plan to use on a computer that is 
using an NTFS file system, you must build the layer on a computer that is using the 
NTFS file system. If you build a layer on a computer that is using the FAT file system, no 
rights will be used and when the layer is moved to a computer that is using the NTFS file 
system, all files and directories will simply get default rights.

When a layer is exported, the rights that are contained in the file system are 
represented in a file called “acls” in SDDL format. At import time, after the files and 
directories have been extracted, this information is used to re-apply the proper rights.

Rights to services are handled in a similar fashion. An SDDL string is generated and used 
to maintain the proper rights on the service.

Hiding the FSLRDR Redirect Locations

The SVS File System Filter driver has the ability to actively hide the fslrdr redirect 
locations in the registry and the file system. These areas are already protected with 
ACLs so that, by default, limited rights users are not able to enter these areas. Causing 
the driver to actively hide these areas has the advantage that the locations are not 
visible to anyone even if the system is configured to show hidden files. The disadvantage 
of using this is that programs that traverse the entire file system looking for data 
(Example: anti-virus scanners and inventory programs) will not see these areas either. 

Note
Enabling this does not affect run-time virus checking. To enable the active hiding of the 
redirect locations by the driver, create a value called “HideRedirectAreas” of type 
DWORD under HKLM\SYSTEM\Altiris\FSL. Set the value to “1”. A restart is required to 
put into effect any changes to this value.
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Launching of Startup Items

The information in this section does not apply when a layer is activated at start time 
because it is marked to be active on start. This only applies when a layer is manually 
activated.

When a layer is activated, Software Virtualization Solution typically launches all of the 
items in the layer that are configured to run at startup. This includes entries in the 
startup folder, the common startup folder, run entries, and run-once entries. The 
launching of these programs happens in the context of the user that activates the layer. 
This is a potential security concern. Example: When a layer is activated remotely by 
Notification Server, this happens in the SYSTEM context by default. Because of this, 
Software Virtualization Solution will not launch these items unless the activation is being 
done by the interactive user who is logged on to the system.

This does not apply to the OnEvent actions. OnEvent actions are run regardless of how 
the layer is activated. Care must be taken to ensure that actions configured to run in 
these scenarios are secure and cannot be exploited by any users on the system.
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Part III
Using Software Virtualization Solution in a 
Notification Server Environment

The following chapters explain how to use Software Virtualization Solution in the 
Notification Server Environment:

Software Virtualization Solution Overview (page 73)

Installing Software Virtualization Solution (page 81)

Getting Started with Software Virtualization Solution (page 83)

Configuring Software Virtualization Solution (page 89)

Using Software Virtualization Solution (page 93)



 

Chapter 6
Software Virtualization Solution Overview

Software Virtualization Solution lets you remotely deploy and manage virtual 
applications and data using Notification Server-based packages and policies. Software 
Virtualization Solution works similarly to Software Delivery Solution and shares many 
features.

Quick Links

Software Virtualization Solution Components (page 73)

Software Virtualization Solution Usage Overview (page 77)

Software Virtualization Solution Features (page 78)

Software Virtualization Solution Components
When Software Virtualization Solution is installed, folders and items are placed in 
various tab views of the Altiris Console. You can use these folders and items to create 
and manage packages, programs, and software virtualization tasks. All folders and items 
for Software Virtualization Solution are placed in the Software Management > 
Software Virtualization > Windows folder in the left pane of the various tab views.

Virtual Software Packages Overview

Package Download Overview

Tasks tab

The following table lists the shortcut menu items that are added after Software 
Virtualization Solution is installed. These can be accessed when you right-click a folder 
or item in the left pane on the Tasks tab.

Resources tab

The Virtual Software Package folder is provided as a container for the software 
virtualization packages that you create.

You can also manage the virtual packages on client computers. You can do this in one of 
two ways:

Folder Shortcut Menu 
Item

Description

Virtual Software 
Tasks

A container for the software virtualization tasks 
that you create.

Wizard and Status Opens the software virtualization Wizard. This 
wizard takes you through the steps of creating 
packages and setting up software virtualization 
tasks to deliver those packages. See Creating 
Virtual Software Packages (page 93).
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Open a computer resource and view and manage the Virtual Software Packages on 
the computer.

Open a Virtual Software Package Resource and view and manage it on the 
computers it is deployed to.

For information, see Managing Virtual Software Packages using the Resource Manager 
(page 113).

Reports tab

From the Reports tab, you can view software virtualization reports. Reports let you 
analyze your data. Each Altiris solution includes predefined reports that you can use or 
modify, or you can create your own reports.

Software Virtualization Solution provides numerous predefined reports to help you 
analyze your asset information.

These reports are found in the Altiris Console under the Reports tab by selecting 
Reports > Software Management > Software Virtualization > Windows in the 
left pane. 

In addition to the above reports, you can create reports related to software virtualization 
task usage. Software Virtualization Solution also provides the ability to automatically 
delete old reports.

For information on these features, as well as using predefined reports and creating 
custom reports, see Altiris Notification Server Reference.

Configuration tab

From the Configuration Tab, you can install, upgrade, or install the Software 
Virtualization Agent. You can also assign security privileges for software virtualization 
administrative functions. For information, see Installing Software Virtualization Solution 
(page 81).

Virtual Software Packages Overview
Virtual Software Packages are Notification Server resource objects that are used to 
deploy virtual applications or virtual data layers to managed client computers. These are 
similar to Software Delivery Packages that are used in Software Delivery Solution.

Virtual Software Packages contain Virtual Software Archive (VSA) files that are created 
using the Software Virtualization Solution Admin (SVS Admin) tool. For information on 
creating VSAs, see Getting Started with Virtual Software Layers and Archive Files 
(page 24).

As part of the package definition process, you specify the locations from which an Altiris 
Agent can download the package. By default, a package can be downloaded from the 
location specified in the package as the source for the package. You can also specify 
Package Servers where a package can be obtained. Package Servers let you reduce the 
load on the Notification Server and the network by distributing packages to multiple 
locations from which they can be downloaded. For more information on package servers, 
see the Altiris Notification Server documentation.

The Altiris Agent stores package files on the same drive that the agent installed (in the 
install path\Altiris\Altiris Agent\software virtualization\Package GUID folder). When 
installing the Altiris Agent, install the Altiris Agent on a drive with sufficient space for all 
the files that will be downloaded. If the Altiris Agent does not have sufficient disk space 
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to download a package, a message is displayed by the Altiris Agent and a status 
message is sent to the Notification Server. If the end user manually deletes the package 
files, the Altiris Agent will re-download them from the Notification Server the next time 
the Altiris Agent tries to run the package. 

Virtual Software Package Actions and States
When a package is deployed to a client computer, there are different actions that you 
can perform on it. Those actions control the two different states of a package: activated 
and deactivated. The following table describes the possible actions and states: 

Name Description

Layer Actions

Import The layer files in a VSA file are installed in the hidden SVS 
redirection area on the client computer. However, imported files 
are not visible until the layer is activated.

Activate The layer files that have been imported on a client computer are 
made visible to the user. Activation and deactivation occur almost 
instantaneously.

Deactivate The imported layer files are hidden from the user but are kept on 
the computer. 

Note
You cannot deactivate a layer while a process is running from that 
layer. For information, see Deactivating Layers with Services 
Running (page 37).

Deactivate 
(Force)

The layer is forcefully deactivated by killing all the running 
applications from that layer. This might cause undesired results.

Delete The imported layer files are removed from the computer.

Delete (Force) The layer is forcefully removed by killing all the running 
applications from that layer. This might cause undesired results.

Reset Deletes all of the user’s profiles in a layer that were added or 
changed. The data in the Writeable sublayer is deleted, leaving 
only the files in the Read-only sublayer. See Resetting Layers 
(page 37).

Note
Data layers cannot be reset. Hence, “Reset”, “Reset and Activate” 
and “Reset and Deactivate” are not available for data layers.

Reset (Force) Deletes all of the user’s profiles in a layer that were added or 
changed, killing all the running applications from that layer. This 
might cause undesired results.

Layer States

Activated The imported layer files are made visible to the user.

Deactivated The imported layer files are hidden from the user.

Combination 
of Actions and 
States
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Virtual Software Package Programs

You can configure tasks to perform actions to control the state of the Virtual Software 
Packages. Software Virtualization Solution provides the following predefined programs:

For information on defining Virtual Software Packages, see Creating and Using 
Notification Server Virtual Software Packages (page 93). For information on defining 
Virtual Software Tasks, see Deploying Virtual Software Packages (page 101).

Package Download Overview
When a new package is defined, the package will be automatically downloaded to the 
appropriate Altiris Agent Package Server the next time the Altiris Agent requests 
configuration information from Notification Server. If you modify a package definition 
within the Altiris Console, the changed files in the package will also be downloaded to 
the appropriate Altiris Agent computers when the Altiris Agents check for configuration 
information.

To send a package to a group of computers, the package must be assigned to a software 
virtualization task, the destination computers must be a part of a collection assigned to 

Import and 
Activate

The layer files are placed in the SVS redirection area on the client 
computer and are made visible to the user.

Reset and 
Activate

The layer files are reset to their original imported state by 
deleting all user data and changes (Writeable sublayer), and the 
layer is visible to the user.

Reset and 
Deactivate

The layer files are reset to their original imported state by 
deleting all user data and changes (Writeable sublayer), and the 
layer is not visible to the user.

Virtual Software Package Program Options

Name Function

Import and 
Activate

Use this to deploy the Virtual Software Package, import the layer, and activate 
the layer. This means the package contents will be copied to the client 
computer and the files will be visible to the user. 

Import Use this to deploy the Virtual Software Package and import the layer, but not 
make the files visible to the user.

Activate Use this to activate a Virtual Software Package that has been imported, but is 
not currently visible to the user.

Deactivate Use this to make an imported Virtual Software Package not visible to the user.

Reset Use this to return the Virtual Software Package to its original imported state 
and delete all user data and changes. The package remains in the activated/
deactivated state that it is currently in.

Reset and Activate Use this to return the Virtual Software Package to its original imported state by 
deleting all user data and changes, then making the files visible to the user.

Reset and 
Deactivate

Use this to return the Virtual Software Package to its original imported state by 
deleting all user data and changes, then make the files not visible to the user.

Delete Use this to delete Virtual Software Packages from the client computers.

Name Description
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the task, and the task must be enabled. For information, see Deploying Virtual Software 
Packages (page 101).

If the actual files in a package change, Notification Server automatically recognizes the 
changes. Notification Server checks for changed package files on a regular basis (once a 
day by default). If Notification Server determines that files in a package have changed, 
Notification Server will inform the appropriate Altiris Agents that the package has 
changed. Only the changed files will be downloaded to the Altiris Agent again. The 
interval that Notification Server checks for changed files can be modified (for 
information, see Changing the Check for Updated Package Files Schedule on page 100). 
The less frequently the check is made, the longer the time is required for a changed 
package to be available on an Altiris Agent computer. The more frequently the check is 
made, the more processing resources are required by Notification Server.

If the Software Virtualization Solution Agent cannot download a package due to a link 
failure or denied access so a connection cannot be established, the Altiris Agent will 
report a “Download failed - Link failure” status message. The Software Virtualization 
Solution Agent will back off for N minutes (where N increases exponentially from a 
default of 3 minutes to a default of 2 hours) before attempting to download the package 
again.

If the Altiris Agent detects a network status change (a new network link), any package 
waiting for a retry at being downloaded immediately restarts. The back off interval is 
then reset to the initial value.

If a connection is lost during the download of a package, the transfer rate is throttled. 
When the Altiris Agent attempts to download the package again, a buffer transfer delay 
applies and slows down the download. The Altiris Agent determines which files in the 
package still need to be downloaded and downloads those files.

If a source or destination fails during a package download, the checkpoint recovery 
feature lets you continue the download of a package without starting over. Example: You 
are deploying a package that is 20 MB in size and there is a network failure 15 MB into 
the deployment process. When your systems are back up, the package deployment 
resumes at the 15 MB point. The checkpoint recovery feature is always available; you do 
not need to enable it.

Software Virtualization Solution Usage Overview
Using Software Virtualization Solution involves defining Virtual Software Layers and 
Packages, creating Software Virtualization Tasks to deploy packages, and monitoring 
feedback. The following steps outline the virtual software deployment procedure.

To deploy a Virtual Software Package

1. Install Software Virtualization Solution on a Notification Server. See Installing 
Software Virtualization Solution (page 81).

2. Create Virtual Software Layers and Archive Files to include in Virtual Software 
Packages. See Getting Started with Virtual Software Layers and Archive Files 
(page 24).

3. Rollout the Software Virtualization Agent to client computers. See Deploy the 
Software Virtualization Agent (page 84).

4. Use the Software Virtualization Wizard to do the following:

Create a Virtual Software Package 
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Create a Software Virtualization Task to deploy the Virtual Software Package to 
client computers 

You can quickly create both packages and tasks using the Software Virtualization 
Wizard. For information, see Create a new Virtual Software Package and Task 
(page 84).

For information about manually creating packages and tasks, see Manually Creating 
Virtual Software Packages (page 94) and Manually Creating a Virtual Software Task 
(page 105).

Software Virtualization Solution Features
Software Virtualization Solution shares the following features with Software Delivery 
Solution:

Bandwidth Throttling (page 78)

Blockout (page 78)

Multicasting (page 79)

Software Portal (page 80)

Bandwidth Throttling
Bandwidth throttling lets you control the amount of bandwidth used in the delivery of 
packages. This feature can help minimize the impact of software deployment at peak 
network usage times.

When the Software Delivery Agent (which is installed along with the Altiris Agent) 
downloads a file, the agent downloads the file buffer by buffer with a delay between 
each buffer. The buffer size and the amount of delay between buffers are both 
configurable through the Altiris Agent. Different values can be used depending on the 
bandwidth usage.

If bandwidth control is disabled by the user, the Software Delivery Agent will use no (0) 
delay between buffers when downloading files. Effectively, the agent uses all of the 
available bandwidth for package download.

If bandwidth control is enabled, the agent will test the data transfer rate by using full 
bandwidth to download a package for 10 seconds, and then estimate the transfer rate 
during that period of time. If the estimated transfer rate is less than a threshold, the 
agent will then use a delay between buffer downloads to slow down the download 
process. The data transfer rate test is done every two minutes to re-evaluate the link 
speed during the package download. Therefore, bandwidth usage depends on the 
transfer rate of the package download. For more information on the throttling feature, 
see the Altiris Notification Server Reference.

Blockout
Blockout lets you block out times in which packages are delivered with a high priority, 
low priority, or not at all. This feature lets you ensure that package delivery does not 
take up significant network bandwidth during peak usage times. For more information 
on the blockout feature, see the Altiris Notification Server Reference.
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Multicasting

Multicasting lets you transmit packages to a select group of recipients. This feature 
improves Package Server performance on large networks for large customers using 
significant amounts of network bandwidth. It protects Package Servers from being 
overloaded and helps prevent slow network responses when distributing large packages. 

Multicasting reduces the load on Package Servers by reducing the number of Altiris 
Agents that connect to the Package Server and decreases network utilization by 
multicasting package data to peers.

Sample Multicasting Scenario

A remote network segment consists of five Altiris Agents that remotely communicate to 
the Notification Server.

When the first Altiris Agent updates its configuration, it is notified that there is a 
package ready for download. If this Altiris Agent has multicasting enabled, it will begin a 
multicast session and ask if any other Altiris Agents in the segment already have this 
package. As other Altiris Agents in turn update their configuration and are also asked to 
download this package they will join the multicast session to register that they too need 
to download the package. 

The Altiris Agents first negotiate to see who is going to be the 'master' of the session. 
After the minimum numbers of Agents per multicast session join, one of two things will 
occur: 

If one of the Altiris Agents has the package, then it becomes the multicast master. 
The master then waits for the minimum number of agents to join the session. 

If no Altiris Agent in the session has the package, then they negotiate with each 
other and pick a multicast master based on their respective OS, OS type, CPU 
speed, and memory. This has a minimum timeout of 240 seconds. After the master 
is chosen, it downloads the package in the usual manner and then waits for the 
minimum number of agents to join the session. 

The master Altiris Agent then multicasts the package over the physical subnet so that 
each of the Altiris Agents in the multicast session can receive it. 

If an Altiris Agent requests a package after it has been available for some time, it 
attempts to join an existing session or else it begins a multicast session as normal.

This process optimizes the package download procedure. Only one Altiris Agent per 
session will communicate with the Package Server or Notification Server to download the 
package. Previously, each Altiris Agent required bandwidth and CPU usage to 
communicate directly to the Package Server or the Notification Server. Multicasting 
reduces this overhead by reducing significant amounts of network bandwidth usage and 
thereby reducing load on the Package Server or the Notification Server. 

Altiris Agents revert to unicast for downloading packages under the following 
circumstances:

If the Maximum sessions per physical subnet value has been reached, the 
backoff period initiates. If this occurs more times than the Maximum 
transmission attempts per package, the Altiris Agent reverts to unicast.

If an Altiris Agent is connected to the session at less than 64 Kbytes/second, it is 
removed from the session.

If the Maximum bandwidth used for multicasting has been reached.
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If the Maximum sessions per physical subnet value has been reached.

If the package is smaller than the Disable multicast for packages smaller than 
value.

Package Servers and Multicasting

The following applies to Package Servers when multicasting:

Package Servers will always download a package using unicast. 

If there is a Package Server on the subnet that has already downloaded a package, 
it participates in the multicast session as the master.

Configuring Multicasting

You can select to use multicasting on the Advanced tab (Virtual Software Task Page) 
(page 109). By default, all Software Delivery tasks that meet the criteria use 
multicasting.

Caution
For a client computer to be included in a multicasting session, the Altiris Agent on that 
computer must have multicasting enabled. Package multicasting is configured in the 
Package Multicast tab on the Altiris Agent Settings page. 

To enable multicasting

1. In the Altiris Console, click the Configuration tab.

2. Select Configuration > Altiris Agent > Altiris Agent Configuration.

3. Click the policy you want to configure multicasting for. For example, All Desktop 
computers.

4. Click the Package Multicast tab.

5. Select the Allow Altiris Agents to use multicast for downloading packages 
checkbox.

For information on multicasting options, click the help icon.

6. Click Apply.

Software Portal
The Software Portal lets users install software on their computers by executing Software 
Delivery programs for which they have been given permission by the administrator. 
Software Portal options are provided in addition to existing Software Delivery Package 
and Program settings. For information, see Step 4 - Advanced Settings (page 86).
Altiris Software Virtualization Solution Reference 80



 

Chapter 7
Installing Software Virtualization Solution

The following procedures explain the steps to install and configure Software 
Virtualization Solution. 

Software Virtualization Solution Prerequisites (page 81)

Installing Software Virtualization Solution (page 81)

Registration (page 82)

Software Virtualization Solution Prerequisites
Software Virtualization Solution requires the following:

Notification Server

Notification Server 6.0 SP2 or higher

Client Computer

One of the following operating systems:

Windows 2000 Professional SP4 or higher

Windows 2000 Advanced Server SP4 or higher

Windows XP Professional SP1 or higher

Windows Server 2003 or higher

Altiris Agent 6.0

Notification Server and SQL Server

If Notification Server and the Microsoft SQL Server database are NOT running on the 
same computer, make sure that the two computers are in the same time zone and their 
clocks are reasonably synchronized. Differences in times or time zones between the two 
computers can cause package update problems. 

Installing Software Virtualization Solution
Before installing Software Virtualization Solution, review Software Virtualization Solution 
Prerequisites (page 81).

To install Software Virtualization Solution on a Notification Server

1. Select Start > Programs > Altiris > Altiris Console. 

This starts the Altiris Console.

2. Click the Configuration tab. 

3. In the left pane, navigate to Upgrade/Install Additional Solutions.
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4. Click the Available Solutions tab. 

5. Click the Software Virtualization Solution link.

6. Click Start.

This starts the installation of the solution. When the installation is complete, the 
window will automatically close.

Registration
Each Altiris product comes with a 7-day trial license that is installed by default. You can 
register and obtain a 30-day evaluation license through our Web site at www.altiris.com 
or purchase a full product license.

To view your current license, open the Altiris Console, click the Configuration tab, and 
select Licensing.

For more information, see “Licensing Altiris Software” in the Altiris Getting Started Guide 
on the product CD or on our Web site: www.altiris.com/support/documentation
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Chapter 8
Getting Started with Software Virtualization 
Solution

The Getting Started tasks guide you through the basic setup, configuration, and use of 
Software Virtualization Solution. Each task has a procedure and, in some cases, 
exercises to illustrate the steps of the procedure. 

Getting started tasks

1. Create a Virtual Software Archive (VSA) File (page 83)

2. Copy Virtual Software Archive Files (page 83)

3. Deploy the Software Virtualization Agent (page 84)

4. Create a new Virtual Software Package and Task (page 84)

5. Using Software Virtualization Solution Reports (page 87)

Prerequisites for Getting Started tasks

Notification Server 6.0 with SP3.

Software Virtualization Solution 6.0 installed on the Notification Server. See 
Installing Software Virtualization Solution (page 81).

A client computer running a supported Windows operating system. See Software 
Virtualization Solution Prerequisites (page 81).

The Altiris Agent 6.0 installed on the client computer.

Exercise scenario

You are the IT manager. You want to create a virtual application for Mozilla Firefox and 
deploy it using Software Virtualization Solution to managed client computers on your 
network.

Create a Virtual Software Archive (VSA) File
Create a Virtual Software Layer and export it to a Virtual Software Archive (VSA) file to 
include in a Virtual Software Package. For information, see Getting Started with Virtual 
Software Layers and Archive Files (page 24).

Copy Virtual Software Archive Files
After you have created a VSA file, in order to deploy it, you must be able to access it 
from your Notification Server. You can copy it to either your Notification Server, to 
another network share that you can access from your Notification Server, or to a Web 
server.
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Note
The folder the VSA file is in needs to have Read permission at a minimum.

Caution
Notification Server-based software packages are defined as the contents of a given 
folder. If you want a VSA to be delivered as a single file, each VSA must be placed in its 
own folder. If you include more than one VSA file in a folder, then all the VSAs will be 
delivered together in the Software Delivery Package. This will cause additional network 
traffic and extra disk space used on client computers. 

Deploy the Software Virtualization Agent
The Software Virtualization Agent manages the Virtual Software Packages deployed to 
client computers. Each computer that will use Virtual Software Packages must have the 
Software Virtualization Agent deployed on it.

To deploy the Software Virtualization Agent

1. From the Altiris Console, click on the Configuration tab.

2. In the left pane, select Configuration > Solutions Settings > Software 
Management > Software Virtualization > Windows > Software 
Virtualization Agent Rollout > Software Virtualization Agent Install.

3. In the right pane, select Enable.

Caution
Client computers must be restarted after the agent is installed. The default program 
prompts the user for a restart. For more information, see Restart the Client 
Computer Automatically after Agent Install (page 91).

4. Select the collection to install to.

By default, the agent will be installed on all computers in the All Windows 
Computers with NS 6 Altiris Agent collection.

5. Configure the multicast and scheduling options.

For information, click the help icon.

6. Click the Apply button.

Create a new Virtual Software Package and Task
The Software Virtualization Wizard simplifies the steps of creating and delivering new 
and existing Virtual Software Packages. For general information about Virtual Software 
Packages, see Virtual Software Packages Overview (page 74). Because packages are 
delivered through Virtual Software Tasks, this wizard guides you through creating 
packages and setting up tasks to deliver those packages.

This is the easiest and most efficient way to create packages, assign programs to them, 
and set up tasks to deliver them.

You can also select to Use the advanced wizard. When running the Advanced Wizard, 
you also have the option to configure package server options, event logging options, the 
package display name in the Altiris Agent, and task download and execute options. For a 
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description of these options see Advanced tab (Virtual Software Package Page) 
(page 98) and Advanced tab (Virtual Software Task Page) (page 109).

To create and deliver a new Virtual Package

The Software Virtualization Wizard can be accessed by clicking the Tasks tab and 
selecting Software Management > Software Virtualization > Windows > Virtual 
Software Tasks > Wizard and Status, then clicking Run Virtual Software Wizard.

Step 1 - Select Package Options
In this step, you select that you want to create and deliver a new Virtual Package, select 
the package source and location, and select the program you want to run.

Before using the wizard, you must have an existing Virtual Software Archive file (.vsa) 
to use. For information on how to create VSA files, see Getting Started with Virtual 
Software Layers and Archive Files (page 24).

How would you like to begin?

Select Create and deliver a new Virtual Package.

1. Select the package source and location

a. Archive File Source: Select the source of the VSA file. For information, see Copy 
Virtual Software Archive Files (page 83) and Package tab (Virtual Software 
Package Page) (page 95).

Exercise
Select Access package from a local directory on the Notification Server 
computer.

b. Archive File Location: Browse to the VSA file you want to use.

Exercise
Browse to the Firefox VSA.

2. Select the program that will run

Select the program to run for the package. For information about package 
programs, see Virtual Software Package Actions and States (page 75).

The actual command line appears. In most cases you do not need to edit this 
information.

3. Click Next.

The required fields are tested and if the information you entered is correct, the 
wizard goes to Step 2 or 4.

Step 2 - Program Options
In this step, you select how the program will run, which rights to use, and what should 
happen when the program has finished running. For information on program options, 
see Programs tab (Virtual Software Package Page) (page 97).

1. Configure the desired options.

Exercise
Accept the defaults.
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2. Click Next to go to Step 3 in the wizard.

Step 3 - Select Collection and Schedule
In this step, you select the collection of computers to which you want the package of 
software to be delivered and when you want it delivered.

Note
This step will set up a Virtual Software Task to deliver the package.

1. Select the collection to which the package will be delivered

You can only select one collection per Virtual Software Task. If you want to send the 
package to more than one collection, you can either create a collection which 
includes all other collections to which you want to send the package or you can run 
the Software Virtualization Wizard again.

2. Select when to run this task

Manual

User must manually activate the task on the target computer.

If this is selected, the task will not run on the target computer unless the user 
activates it manually.

On a Schedule

If this is selected, the task will run automatically on the target computer.

For information on scheduling options, see General tab (Virtual Software Task 
Page) (page 106).

3. Select On a schedule and accept the defaults. Click Next to go to Step 4 in the 
wizard.

Step 4 - Advanced Settings

If you selected the Use the advanced wizard option, you can configure package 
server options, event logging options, advanced task options, and software portal 
options.

Configure package options

1. Configure the package server and event logging options.

For a description of these options see Advanced tab (Virtual Software Package Page) 
(page 98).

2. Click Next to go to Step 5 in the wizard.

Configure advanced task options

1. Specify the name and description of the virtual task this is displayed on the Altiris 
Agent UI.

2. Specify download and execute options.

For a description of these options, see Advanced tab (Virtual Software Task Page) 
(page 109).

3. Click Finish to go to Step 5 in the wizard.
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Step 5 - Summary
In this step, you enter your task, package, and program names. Next, you review your 
settings, and click the Finish button.

1. Enable or disable the software virtualization task.

If the checkbox is selected, the software virtualization task will be enabled when it is 
created. Software virtualization tasks must be enabled before they can be run.

2. Enter the name for the Virtual Software task, package, and program.

These are the names of the objects as they appear in the Altiris Console. You can 
use the default names or use your own.

3. Verify the information in the table and click OK.

Make sure the information in the table is correct.

4. Click OK.

This creates the Virtual Software Package and software virtualization task and 
attaches the package to the task.

The task will be run according to your scheduling options.

The task is available under the Tasks tab > Software Management > Software 
Virtualization > Windows > Virtual Software Tasks. 

The package is available under the Resources tab > Resource Management > 
Resources > Software Management > Software Virtualization > Windows > 
Virtual Software Packages.

Using Software Virtualization Solution Reports
Software Virtualization Solution provides numerous predefined reports to help you 
analyze your software virtualization information.

The reports are organized into the following categories:

Agents

Packages

The following procedures provide sample instructions for using reports.

To run a report to count the computers with/without the Software 
Virtualization Agent installed

This report will provide a count of the number of computers with and without the 
Software Virtualization Agent installed.

1. In the Altiris Console, click the Reports tab and select Reports > Software 
Management > Software Virtualization > Windows.

2. Click the Agents folder.

3. Click Count of Computers with/without the SVS Agent Installed.

4. Click Run this report in a new window.

5. You can use the default collection, All Windows Computers, or select another.

6. To search for all computers in all domains, leave the fields as Any.
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7. Click Refresh.

A count for both computers without, and with, the SVS Agent is displayed.

To run a report with a count of computers with each Virtual Software 
Package (VSP)

This report will provide a list of each Virtual Software Package (VSP) with a count of the 
number of computers with that VSP.

1. In the Altiris Console, click the Reports tab and select Reports > Software 
Management > Software Virtualization > Windows.

2. Click the Package folder.

3. Click Count of Computers by VSP.

4. Click Run this report in a new window.

5. You can use the default collection, All Windows Computers, or select another.

6. To search for all VSPs and computers in all domains, leave the fields as Any.

7. Click Refresh.

In addition to the predefined reports, you can create custom reports related to Software 
Virtualization task usage. Software Delivery Solution also provides the ability to 
automatically delete old reports.

For information on these features, as well as using predefined reports and creating 
custom reports, see the Notification Server documentation.
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Chapter 9
Configuring Software Virtualization Solution

The following procedures explain the steps to configure Software Virtualization Solution 
in a Notification Server environment. 

Configuring Software Virtualization Security Privileges (page 89)

Deploying and Managing the Software Virtualization Agent (page 90)

Deploying the Software Virtualization Agent (page 90)

Custom Agent Installation Settings (page 91)

Upgrading the Software Virtualization Agent (page 92)

Uninstalling the Software Virtualization Agent (page 92)

Configuring Software Virtualization Security 
Privileges

You can assign security privileges for software virtualization administrative functions. 
Using role-based security, you can control who has rights to do the following:

Create Virtual Software Packages

Create Virtual Software Tasks

Quick Links

Security Role Management Example

Security Privileges Example

Security Role Management Example
You may want to give certain IT staff rights to create Virtual Software Packages. You 
may want to give certain other IT staff rights to only create and deploy Virtual Software 
Tasks based on predefined Virtual Software Packages.

To configure Software Virtualization Security Role Management

1. From the Altiris Console, click on the Configuration tab.

2. In the left pane, select Configuration > Server Settings > Notification Server 
Settings > Security Roles.

3. Under Security Roles, highlight a user role.

4. In the right pane, under Privileges, scroll down to Software Virtualization 
Solution Privileges.

5. Select the privileges that you want the select role to have.

6. Click other roles to assign them privileges as well.

7. Click Apply.
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For information about configuring security, see Security Role Management in the 
Notification Server help.

Security Privileges Example
You may want to give certain IT staff rights to change the status of a Virtual Software 
Package on a client computer without giving the right to use the wizard to create Virtual 
Software Packages.

To configure Software Virtualization Security Privileges

1. From the Altiris Console, click on the Configuration tab.

2. In the left pane, select Configuration > Server Settings > Notification Server 
Settings > Item Tasks.

3. Right-click an item task you want to see security for and click Properties.

4. Click Security.

5. Set the desired security options for this item task.

6. Click Apply.

For more information about configuring security, see Security Role Management in 
the Notification Server help.

Deploying and Managing the Software Virtualization 
Agent

This section describes how to deploy and manage the Software Virtualization Agent.

Deploying the Software Virtualization Agent (page 90)

Custom Agent Installation Settings (page 91)

Upgrading the Software Virtualization Agent (page 92)

Uninstalling the Software Virtualization Agent (page 92)

Deploying the Software Virtualization Agent
The Software Virtualization Agent manages the Virtual Software Packages deployed to 
client computers. Each computer that will use Virtual Software Packages must have the 
Software Virtualization Agent deployed and installed on it. For instructions, see Deploy 
the Software Virtualization Agent (page 84).

Manage This 
Package

This is the right to manage a Virtual Software Package resource that is 
present on various computer resources.

Manage Virtual 
Software 
Packages

This is the right to manage the Virtual Software Packages that are 
present on a specific computer resource.

Software 
Virtualization 
Wizard

This is the right to launch the Software Virtualization Wizard to create 
Virtual Software Packages and task policies.
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Custom Agent Installation Settings

You can modify the agent installation settings to do the following:

Restart the Client Computer Automatically after Agent Install (page 91)

Install SVS Admin Tool during Agent Install (page 91)

Restart the Client Computer Automatically after 
Agent Install
The Software Virtualization Agent Package is used to install the agent. The package has 
three predefined programs:

Installation

Uninstallation

Upgrade

When you use the default Software Virtualization Agent Installation Program, 
client computers will not be restarted by default. However, after the agent installation, 
the client computers must be restarted to enable the agent.

If you want to force a computer restart after the agent is installed, you can modify the 
Software Virtualization Agent Package.

To modify Restart Options for the Software Virtualization Agent 
Package

1. From the Altiris Console, click the Configuration tab.

2. In the left pane, select Configuration > Solution Settings > Software 
Management > Software Virtualization > Windows > Software 
Virtualization Agent Rollout.

3. Select Software Virtualization Agent Package.

4. In the right pane, click the Programs tab.

5. From the After running drop-down list, select Restart Computer.

You can modify the restart option for either the default installation program, or you 
can create a new program, copy all settings from the default installation program, 
and change the After running option in the new program.

For more information about package and program settings, click the help icon.

6. Click Apply.

Install SVS Admin Tool during Agent Install
By default, when you deploy the Software Virtualization Agent, the SVS Admin tool is 
not installed. There is a separate policy that will install the agent with the SVS Admin 
utility.

To Install SVS Admin with the Software Virtualization Agent Package

1. From the Altiris Console, click the Configuration tab.
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2. In the left pane, select Configuration > Solution Settings > Software 

Management > Software Virtualization > Windows > Software 
Virtualization Agent Rollout.

3. Select Software Virtualization Agent Package.

4. In the right pane, click Software Virtualization Agent With SVS Admin Install.

5. In the right pane, select Enable.

6. Use the default Program name.

Caution
Client computers must be restarted after the agent is installed. The default program 
prompts the user for a restart. For information, see Restart the Client Computer 
Automatically after Agent Install (page 91).

7. Select the collection to install to.

By default, the agent will be installed on all computers in the All Windows 2000/
XP/2003 Computers collection. You can use the default or click the link to make 
changes.

8. Configure the multicast and scheduling options.

For information, click the help icon.

9. Click Apply.

Upgrading the Software Virtualization Agent
You can use a policy to upgrade the Software Virtualization Agent from managed 
computers. You would use this policy after upgrading to a new version of Software 
Virtualization Solution that has an updated version of the Software Virtualization Agent.

The Software Virtualization Agent Upgrade policy is found under Configuration > 
Solution Settings > Software Management > Software Virtualization > 
Windows > Software Virtualization Agent Rollout.

Uninstalling the Software Virtualization Agent 
You can use a policy to uninstall the Software Virtualization Agent from managed 
computers. The Software Virtualization Agent Uninstall policy is found under 
Configuration > Solution Settings > Software Management > Software 
Virtualization > Windows > Software Virtualization Agent Uninstall.

By default, this policy uninstalls the Software Virtualization Agent from all computers 
listed in the Computers With Software Virtualization Agent Installed collection. To 
uninstall the agent from a smaller group of computers, you can specify a different 
collection.
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Chapter 10
Using Software Virtualization Solution

This chapter describes the following tasks you can perform using Software Virtualization 
Solution in a Notification Server environment.

Creating and Using Notification Server Virtual Software Packages (page 93)

Deploying Virtual Software Packages (page 101)

Using the Software Virtualization Status Page (page 111)

Managing Virtual Software Packages using the Resource Manager (page 113)

Using the Software Portal (page 114)

Using Notification Policies and Automated Actions (page 114)

Creating and Using Notification Server Virtual 
Software Packages

After you have created Virtual Software Layers and Virtual Software Archive files, you 
can create Virtual Software Packages. For general information about Virtual Software 
Packages, see Virtual Software Packages Overview (page 74).

There are two ways to create Virtual Software Packages.

Creating Virtual Software Packages (page 93)

Manually Creating Virtual Software Packages (page 94)

This section also describes the following:

Editing Virtual Software Packages (page 94)

Virtual Software Packages Page (page 94)

Checking for Package Download Errors

Changing the Check for Updated Package Files Schedule

Creating Virtual Software Packages
The Software Virtualization Wizard simplifies the steps of creating and delivering new 
and existing Virtual Software Packages. Because packages are delivered through Virtual 
Software Tasks, this wizard guides you through creating packages and setting up tasks 
to deliver those packages.

This is the easiest and most efficient way to create packages, assign programs to them, 
and set up tasks to deliver them.

You can also select to Use the advanced wizard. When running the Advanced Wizard, 
you also have the option to configure package server options, event logging options, the 
package display name in the Altiris Agent, and task download and execute options. For a 
description of these options see Advanced tab (Virtual Software Package Page) 
(page 98) and Advanced tab (Virtual Software Task Page) (page 109).
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You can use the wizard in the following two ways:

Create a new Virtual Software Package and Task (page 84)

Create a new Virtual Software Task with an Existing Virtual Package (page 102)

Manually Creating Virtual Software Packages
Note
To quickly create a new Software Virtualization Package and Task at the same time, use 
the Software Virtualization Wizard. For information, see Creating Virtual Software 
Packages (page 93).

To manually create a Virtual Software Package

1. In the Altiris Console, click the Resources tab.

2. In the left pane, select Resource Management > Resources > Software 
Management > Software Virtualization > Windows.

3. Right-click the Virtual Software Packages folder, and select New > Virtual 
Software Package.

4. In the right pane, specify the package properties.

For information about package properties, see Virtual Software Packages Page 
(page 94).

5. Click Apply.

Editing Virtual Software Packages
After you create a virtual software package, you can edit the package. 

To edit a package

1. Open the Virtual Software Packages Page on page 94.

2. Make any desired changes.

3. Save the package.

Virtual Software Packages Page
Note
When configuring package programs, it is important to understand Virtual Software 
Package states and actions. For information on states and programs, see Creating 
Virtual Software Packages (page 93).

This page is used to configure Virtual Software Packages and specify Package Servers 

for the package. It contains the following four tabs:

Package tab (Virtual Software Package Page) (page 95)

Programs tab (Virtual Software Package Page) (page 97)

Advanced tab (Virtual Software Package Page) (page 98)

Software Portal tab (Virtual Software Package Page) (page 99)
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To access the Virtual Software Packages page

1. In the Altiris Console, click the Resources tab.

2. In the left pane, select Resource Management > Resources > Software 
Management > Software Virtualization > Windows > Virtual Software 
Packages.

3. In the right pane, double-click a software package resource or right-click to create a 
new package.

4. In Resource Manager, click the Package tab.

Virtual Software Package Toolbar

The Virtual Software Package toolbar contains icons that let you perform actions while 
using the Virtual Software Package page.

The clickable icons on the Virtual Software Package toolbar are as follows:

Right click menu for item - Displays the right click menu for the folder.

Export - Lets you export the software package to XML.

View as XML - Lets you view the software package as XML.

Properties - Lets you view the Properties page of the Virtual Software Package. 
The Properties page contains general information of the package and also lets you 
set up security for the package.

Package tab (Virtual Software Package Page)
This tab is used to configure a package. Items in italics are settings options.

Package tab page items

Item Description

Name Name of the package.

Description Description of the package. 

Publisher Publisher of the package.

Language Language for which the package is designed.

Version Version of the package.
Altiris Software Virtualization Solution Reference 95



 

Archive File 
Source

Drop-down list with the following options:

Package does not contain source files:

Select this if the package does not contain source files. Normally, you 
would not use this option for Software Virtualization Solution.

Access package from a local directory on the NS computer:

Select this to access the package from a local directory on the 
Notification Server computer. If this is selected, you must enter a 
Package Location. Notification Server will map HTTP URLs to this 
location through which Altiris Agents will access the package. 

Package Location: The location of the package on a local directory on 
the Notification Server computer. 

Access package from existing UNC:

Select this to access the package from an existing Universal Naming 
Convention (UNC) path.

In order for the Notification Server to access packages that exist at a 
UNC path, you must first enter the credentials that the Notification 
Server will use when connecting to the UNC path. To do this, go to the 
Package Server Configuration page and fill in the credentials in the 
Distribution Point Connection Parameters drop-down list.

This option requires a package location. Notification Server will map 
HTTP URLs to this location through which the Altiris Agents will access 
the package. 

Package Location UNC: The location of the package at a UNC path.

Access package from a URL:

Select this to access the package from a URL. This option requires a 
package location URL.

Package Location: The Altiris Agent will access the package through this 
anonymous URL.

Archive File Directory: The alternate UNC package location when the 
Package source is Access Package from a URL.

This UNC package location is used to generate a snapshot of all of the 
files in the package. The URL is the location where the Altiris Agent will 
download the package from. The snapshot is used by Altiris Agents as a 
list of files that will be downloaded. This UNC package location should 
be the path to the directory used to create the virtual directory.

Archive File 
Location

The location of the Virtual Software Archive file. This can be a local 
directory, a UNC path, or URL location depending on the package 
source. 

Apply Click Apply to save changes.

Cancel Click Cancel to discard changes.

Update 
Distribution Point

Click this button to update this package information as soon as possible 
on all enabled Package Servers.

Package tab page items (Continued)

Item Description
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Programs tab (Virtual Software Package Page)
This tab is used to configure the programs associated with a package. Software 
Virtualization Solution provides several predefined programs.

Select a program from the drop-down list to view the details on that program. To add a 
new program to the package, click New. To delete a program from the package, select 
the program from the drop-down list and click Delete.

Program tab page items

Item Description

Program Drop-down list that lets you select the program to be associated with 
the selected package. The programs defined here will be available when 
you create a Virtual Software Task for this package. 

New Creates a new program definition using the information currently listed 
in the Program Details section of the page.

Delete Deletes the program definition selected in the Program drop-down list.

Name (Required) Name of the program.

Description (Optional) Description of the program. 

Command line (Required) Command line entry to run the program, including switches 
and parameters if applicable. If you use a predefined program, the 
correct information is inserted. For information on command-line 
options, see “Advanced Virtual Software Layer Topics” in the Altiris 
Software Virtualization Solution Reference.

Estimated disk 
space

(Optional) Estimated disk space required by the installed program. This 
is only an information field.

Estimated run 
time

(Optional) Estimated time in minutes required to complete the 
deployment. This is only an information field.

Terminate after (Optional) Terminates running of the program after the specified 
number of minutes.

After running (Optional) Specifies the action to take after running the program. The 
options are No action required, Restart computer, and Log off 
user.

Starting window Specifies the status of the program window when the program is run. 
The options are Normal, Hidden, Minimized, and Maximized.

Run with rights Specifies whether the program is run with the System Account, 
Logged in User, or Specified User account. If you select the 
Specified User, you must specify the user’s domain, name, and 
password in the field below.

User domain Domain information of the account to use if you use Specified User in 
the Run with Rights field. Enter the domain, user name, and password 
of the specified user.

Program can run Specifies the conditions in which the program can run. The options are: 

Only when a user is logged on

Whether or not a user is logged on

Only when no user is logged on
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Advanced tab (Virtual Software Package Page)
This tab is used to specify Package Servers associated with a package. For information 
on Package Servers, see the Altiris Notification Server Help and Altiris Notification 
Server Reference.

Advanced tab page items

Item Description

Agent display name The name of the package that will be displayed on the Altiris Agent. 
This can be different than the package name you specified on the 
Package tab. 

The purpose of this field is for you to be able to supply package 
names to the end user that makes sense to users while also being 
able to have package names that make sense to you on an 
administrative level.

Agent display 
description

The description of the package that will be displayed on the Altiris 
Agent. This can be different than the package description you 
specified on the Package tab. 

It is recommended that you enter a description here that will let the 
end user know what the package will do to the managed computer.

Enable verbose 
reporting of package 
status events 

This setting controls whether the Altiris Agent sends all package 
status events for this package to the Notification Server. Select the 
check box to enable sending all package status events to the 
Notification Server. 

Note
The Advanced Settings in the Configuration tab take precedence 
to this setting. Events are only sent if their corresponding check box 
is enabled in the Capture Event Name section of the Advanced 
Settings.

The following types of Status events are not sent if package verbose 
reporting events are disabled:

Package Updated

Package Added

Package To Be Removed

Package Removed

Unable To Check Package

Insufficient Disk To Download Package

Download Start

Download Complete

Package Download Blocked

For information on capturing events in large environments, see 
“Scalability” in the Altiris Notification Server Reverence.
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Software Portal tab (Virtual Software Package 
Page)
This tab lets you view and modify Software Portal permissions for the programs found in 
this package.

Note
The Software Portal tab will be visible only if Software Delivery Solution is installed. 

The Software Portal is used to manage the availability of software that can be added 
manually by a user from the managed computer.

Use Alternate 
Download Destination 
on Client

Select this to use an alternate package download destination to the 
managed computer besides the default.

This option makes it possible to deliver package files to computers 
at alternate destinations. When the task executes, the package files 
will be copied from the internal cache location to the location 
specified. 

After they are copied, the copied package files will never be deleted 
by the Altiris Agent. They will be recopied every time the task is 
run; so if the task is on a recurring schedule, the files will be copied 
repeatedly. This can be useful to ensure the user does not delete a 
required file.

Note
The default of the internal cache location is install path\altiris\altiris 
agent\software virtualization\{package guid}\cache).

Package servers 
Settings

All Package Servers Select this to send the package to all available Package Servers.

Selected Package 
Servers

Select this to show a table of available Package Servers. You can 
then choose the Package Servers that you want this package sent 
to.

Enabled Package 
Servers

This table lists the Package Servers available for your Notification 
Server. 

The Package Servers section lets you specify which Package 
Servers you would like this package to be replicated to. The grid 
contains a list of all Package Servers that have been created for the 
Notification Server. Select the box in the enabled column next to 
each of the Package Servers that you wish this package to be 
replicated to. The default and recommended option is to have the 
package replicated to all Package Servers (by selecting All 
Package Servers). 

All selected computers will have the package copied to them.

Package Destination 
Location on Package 
Servers

Enter the desired package destination location on the Package 
Servers if you do not want the default. Enter a UNC path.

The default package delivery location on Package Servers is install 
path\altiris\altiris agent\package delivery\{package guid}\cache).

Advanced tab page items (Continued)

Item Description
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The table lists the programs that are currently defined for the package and the state of 
their Software Portal permissions.

When you click a program in the table, you can see who has permission to install the 
software without administrator approval (Install Software permission) and who requires 
administrator approval before installing the software (Install On Approval permission).

When you click the Modify button, the Security Descriptor dialog appears. This lets you 
modify the security settings for the program by group, user, or Altiris role, by defining 
the Software Portal permissions you desire.

You can use Alert Manager and the Software Portal to retrieve user software requests, 
approve or deny them, and send out e-mails if required.

For more information about how to use the Software Portal with Software Virtualization 
Solution, see the Best Practices section of the Altiris Software Virtualization Solution 
Reference.

Checking for Package Download Errors
After deploying packages, we recommend verifying that the packages were deployed 
successfully. If some packages were not successfully deployed, you need to know on 
which computers the deployment was not successful. To facilitate this process, Software 
Delivery provides the “Package download errors” report.

To determine package download errors

1. In the Altiris Console, click the Reports tab. 

2. In the left pane, select Reports > Software Management > Software Delivery 
> Windows > Client Package Download > Package Download - Errors item.

3. In the right pane, click the Run this report link. 

A report using the latest data will be created displaying package deployment error 
information. You can click on items in the report to drill down for more details.

Tip
For other client status information, use the above procedure, but select one of the other 
reports.

Changing the Check for Updated Package Files Schedule
By default, Notification Server checks all packages every day for changes. You can 
change this schedule as needed. For information on how software packages are 
updated, see Package Download Overview (page 76).

To change the check for updated package files schedule

1. In the Altiris Console, click the Configuration tab. 

2. In the left pane, select Configuration > Server Settings > Notification Server 
Settings > Shared Schedules.

3. In the right pane, click on the Package Refresh schedule link.

4. In the Schedule Editor dialog, specify the desired schedule, and click OK.
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Deploying Virtual Software Packages

Virtual Software Tasks deploy Virtual Software Packages. 

Quick Links

Virtual Software Task Overview (page 101)

Virtual Software Task Priority (page 101)

Virtual Software Task Status Files (page 102)

Disabled Virtual Software Tasks (page 102)

Creating Virtual Software Tasks (page 102)

Virtual Software Task Page (page 105)

Verifying that a Policy Has Been Successfully Delivered to the Altiris Agent 
Computer (page 111)

Virtual Software Task Overview
Virtual Software Tasks are policies that specify delivery and deployment information 
about a Virtual Software Package. For a Virtual Software Package to be downloaded to 
and deployed on the managed computer, there must be at least one Virtual Software 
Task associated with that package. Each package can have more than one task 
associated with it, but each Virtual Software Task is only associated with one package.

Virtual Software Tasks have several options on how they are run, depending upon how 
they are configured. A Virtual Software Task can be run:

By the user of the managed computer through the Altiris Agent program or Software 
Portal.

As soon as possible after the task has been requested by the Altiris Agent and the 
run conditions are met. The run conditions are specified in the package definition 
policy on the Programs tab. The condition options are Only when a user is 
logged on, Only when no user is logged on, and Whether or not a user is 
logged on.

According to a schedule specified in the Virtual Software Task.

Each Virtual Software Task has availability dates associated with it. These dates specify 
when a task is first available and no longer available. The Virtual Software Package 
associated with a task specifies the security context under which a program runs (local 
system administrator or logged on user rights).

For information on creating a Virtual Software Task, see Manually Creating a Virtual 
Software Task (page 105).

Virtual Software Task Priority
Each Virtual Software Task has an associated priority that is set in the definition of the 
Virtual Software Task. The priority is used to set a priority when more than one Virtual 
Software Task needs to download an associated package. The package associated with 
the Virtual Software Task having the highest priority is downloaded first.

The Virtual Software Task will also be executed according to their priority order. Each 
task will be executed to completion before another task is started.
Altiris Software Virtualization Solution Reference 101



 

The priority options are Low, Normal, High, and Very High.

Virtual Software Task Status Files
The Software Virtualization Solution Agent keeps track of package download status 
information for each package in a status file. The status is kept here: install 
path\Altiris\Altiris Agent\software virtualization\Status\package guid\log.xml.

This file keeps track of the last 30 download attempts. This value can be adjusted by 
editing the registry value “Download history size” located under the key 
“HKLM\SOFTWARE\Altiris\Communications\Package Delivery” on the client computer.

The Software Virtualization Solution Agent keeps track of package execution status for 
each task in the install path\Altiris\Altiris Agent\software 
virtualization\AexSWDPolicy.xml file.

Disabled Virtual Software Tasks
If you disable a Virtual Software Task, or it is disabled due to platform mismatch, 
expiration, filtering, or unavailability, the Software Virtualization Solution Agent will keep 
that task’s status information for 10080 minutes (one week) by default, including any 
downloaded packages. After one week, the associated status information is removed 
entirely from the Altiris Agent computer. If the associated packages are no longer 
referenced by any other active Virtual Software policies on the Altiris Agent, the 
packages are also removed. (If you re-enable the policy after one week, any associated 
software packages are downloaded again.) The one-week default can be changed by 
modifying the software virtualization package and changing the package deletion option.

This cleanup process is performed once a day. For testing purposes, you can force a 
cleanup within the next 5 minutes by removing the AdsStatusLastCleanUp registry value 
under the following registry key:

HKLM\Software\Altiris\Altiris Agent\software virtualization

The following registry setting configures how long, in minutes, a Virtual Software Task 
must be disabled before the status and packages are removed from the Altiris Agent 
computer.

HKLM\Altiris\Altiris Agent\software virtualization\RemovedSoftPkgsCleanUpPeriod

Creating Virtual Software Tasks
There are three ways to create Virtual Software Tasks:

Create a new Virtual Software Package and Task (page 84)

Create a new Virtual Software Task with an Existing Virtual Package (page 102)

Manually Creating a Virtual Software Task (page 105)

Create a new Virtual Software Task with an Existing 
Virtual Package
The Software Virtualization Wizard simplifies the steps of delivering existing Virtual 
Software Packages by setting up tasks to deliver those packages. This is the easiest and 
most efficient way to set up tasks to deliver packages.
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The Software Virtualization Wizard can be accessed by clicking the Tasks tab and 
selecting Software Management > Software Virtualization > Windows > Virtual 
Software Tasks > Wizard and Status and clicking Run Software Virtualization 
Wizard.

You can also select to Use the advanced wizard. When running the Advanced Wizard, 
you also have the option to configure package server options, event logging options, the 
package display name in the Altiris Agent, and task download and execute options. For a 
description of these options, see Advanced tab (Virtual Software Package Page) 
(page 98) and Advanced tab (Virtual Software Task Page) (page 109).

In this scenario, you will deliver an existing Virtual Software Package. For instructions on 
using the wizard to create and delivery a new package, see Create a new Virtual 
Software Package and Task (page 84).

Step 1 - Select Package Options
In this step, you select that you want to deliver an existing package and select the 
package you want to deliver.

How would you like to begin?

Select Deliver an existing virtual package.

1. Select an existing virtual package.

The existing packages in the default package location are displayed. If you have not 
yet created the package you want to deliver, see Creating and Using Notification 
Server Virtual Software Packages (page 93).

2. Verify package details.

Verify that this is the package you want by observing the name, description, and 
location of the package.

3. Select a program to run from within the package.

Select a program that has been attached to the package. If the program you want to 
run is not attached to the package, you must cancel this wizard and edit the 
package. For information about package programs, see Creating Virtual Software 
Packages (page 93).

4. Click Next to go to Step 2 in the wizard.

Step 2 - Select Collection and Schedule
In this step, you select the collection of computers to which you want the package of 
software to be delivered. Next, you select when you want it delivered.

Note
This step lets you set up a Virtual Software Task to deliver the package.

1. (Required) Select the collection to which the package will be delivered.

You can only select one collection per Virtual Software Task. If you want to send the 
package to more than one collection, you can either create a collection which 
includes all collections to which you want to send the package or you can run the 
Software Virtualization Wizard again.

2. Select when to run this task.

Manual
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User must manually activate the task on the target computer.

If this is selected, the task will not run on the target computer unless the user 
activates it manually.

On a Schedule

If this is selected, the task will run automatically on the target computer.

For information on scheduling options, see General tab (Virtual Software Task 
Page) (page 106).

3. Click Finish to go to Step 3 in the wizard.

Step 3 - Advanced Settings
If you selected the Use the advanced wizard option, you can configure package 
server options, event logging options, and advanced task options.

Configure package options

1. Configure the package server and event logging options.

For a description of these options see Advanced tab (Virtual Software Package Page) 
on page 98

2. Click Next to go to Step 4 in the wizard.

Configure advanced task options

1. Specify the name and description of the virtual task this is displayed on the Altiris 
Agent UI.

2. Specify download and execute options.

For a description of these options see Advanced tab (Virtual Software Task Page) 
(page 109).

3. Click Finish to go to Step 4 in the wizard.

Step 4 - Summary
In this step, you enter a name for your task, review your settings, and then click the 
Finish button.

In this step, you enter your task, package, and program names. Next, you review your 
settings, and click the Finish button.

1. Enable or disable the Virtual Software Task.

If the checkbox is selected, the Virtual Software Task will be enabled when it is 
created. Virtual Software Tasks must be enabled before they can be run.

2. Enter the name for the Virtual Software task.

This is the name of the task as it appears in the Altiris Console. You can use the 
default name or use your own.

3. Verify the information in the table and click OK.

4. Click OK.

This creates the Virtual Software Package and attaches the selected package to the 
task.
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The task will be run according to your scheduling options.

The task is available under the Tasks tab > Software Management > Software 
Virtualization > Windows > Virtual Software Tasks. 

Manually Creating a Virtual Software Task
For general information on Virtual Software Tasks, see Deploying Virtual Software 
Packages (page 101).

Note
To quickly create a new Software Virtualization Package and Task at the same time, use 
the Software Virtualization Wizard. For information, see Creating Virtual Software 
Packages (page 93).

To create a Virtual Software Task

1. In the Altiris Console, click the Tasks tab. 

2. In the left pane, select Tasks > Software Management >Software 
Virtualization > Windows.

3. Right-click the Virtual Software Tasks folder and select New > Virtual Software 
Task.

4. In the right pane, specify the Virtual Software Task details.

For information about task properties, see Virtual Software Task Page (page 105).

If you want to verify that a Virtual Software Task has been deployed properly, see 
Verifying that a Policy Has Been Successfully Delivered to the Altiris Agent Computer 
(page 111).

Virtual Software Task Page

This page lets you configure Virtual Software Tasks. It contains the following three tabs:

General tab (Virtual Software Task Page) (page 106)

Advanced tab (Virtual Software Task Page) (page 109)

Status tab (Virtual Software Task Page) (page 110)

To access a Virtual Software Task page

1. In the Altiris Console, click the Tasks tab.

2. In the left pane, select Tasks > Software Management > Software 
Virtualization > Windows > Virtual Software Tasks.

Virtual Software Task Toolbar

The Virtual Software Task toolbar contains icons which let you perform actions while 
using the Virtual Software Task page.
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The clickable icons on the Virtual Software Task toolbar are as follows:

Rename - Lets you quickly rename the Virtual Software Task.

Delete - Lets you quickly delete the Virtual Software Task.

Clone - Lets you clone the Virtual Software Task.

Export - Lets you export the Virtual Software Task to XML.

View as XML - Lets you view the Virtual Software Task as XML.

Properties - Lets you view the Properties page of the Virtual Software Task. The 
Properties page contains general information of the task and also lets you set up 
security for the task.

General tab (Virtual Software Task Page)

General tab page items  

Item Description

Enable Enables the Virtual Software Task when selected. Disables the Virtual 
Software Task when cleared.

Name Name of the Virtual Software Task.

Description Description of the Virtual Software Task.

Priority Defines the order in which packages associated with Virtual Software 
Task are downloaded. Can be Low, Normal, High or Very high.

Packages associated with higher priority Virtual Software Task get 
downloaded before those for lower priority Virtual Software Task. Any 
package that is being downloaded will be suspended if a higher priority 
Virtual Software Task arrives.

Package name Specifies the package to be used by the Virtual Software Task. Clicking 
on the link will open the Package Selector.

Go to Package Opens the Package page for the package selected in the Package 
Name field.

Program Name Name of the program to run. The list of available options in the drop-
down list depends on the value selected in the Package field.

Go to Program Opens the Program page for the program selected in the Program 
name field.
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Applies to 
Collection

Specifies the collection to which the software task applies.

Clicking on the link will open the Collection Selector.

Note
You must select at least one collection before you can apply the Virtual 
Software Task.

Run - Manual Select manual to run the software virtualization task manually and not 
according to a schedule.

You can choose one or both of the following:

Notify the user when this task is available - Select this to notify the 
user when this Virtual Software Task becomes available to run. The user 
can then control when to run the Virtual Software Task.

Warn the user before running this task - Select this to warn the 
user before a software virtualization task is run. The user can then 
choose to cancel the task, run the task immediately, or be reminded 
later.

General tab page items (Continued) 

Item Description
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Run - On a 
schedule

Specifies that the software virtualization task is to be run according to a 
schedule.

You can schedule for the software virtualization task to be run as soon 
as possible and/or set up a schedule for it to be run.

You can choose one or more of the following:

Run as soon as computer is notified (only runs once) - Select this 
to run the software virtualization task as soon as the package has been 
downloaded to the managed computer and the run conditions have been 
met. This option creates a mandatory software virtualization task that 
does not display a dialog on the managed computer before running.

Run on a schedule - Select this to run the software virtualization task 
on a schedule. Click No schedule has been defined to open the 
Schedule Editor. Select one of the following:

Run ‘as soon as possible’ after the scheduled time - This 
option tells the Altiris Agent to run the software virtualization task 
as soon as possible after the time you have scheduled. The Altiris 
Agent will wait until the scheduled time, then run the software 
virtualization task as soon as it can. This option can help spread out 
the network load as the software virtualization tasks will most likely 
run at different times on each Altiris Agent.

Only run at scheduled time - This option tells the Altiris Agent to 
run the software virtualization task only at the scheduled time. This 
option will force all Altiris Agents to run the software virtualization 
task at the same time.

Power up the computer (Wake on LAN) - Select this to send a 
power up signal to the managed computer at the designated scheduled 
time.

Immediately notify each computer of task - Select this to 
immediately notify all computers of the software virtualization task at 
the designated scheduled time. This can lead to increased network 
traffic and should be used carefully.

User can run this task immediately - Select this to let the user run 
the software virtualization task immediately when it becomes available.

Notify the user when this task is available - Select this to notify the 
user when this software virtualization task becomes available to run. 
The user can then control when to run the software virtualization task.

Warn the user before running this task - Select this to warn the 
user before a software virtualization task is run. The user can then 
choose to cancel the task, run the task immediately, or defer the task.

Use Recovery to 
backup the 
computer

If this is selected, Software Virtualization Solution performs a Recovery 
snapshot on the Altiris Agent prior to running the software virtualization 
task.

Note
This option only appears if you have Recovery Solution 6.0 or greater 
installed.

General tab page items (Continued) 

Item Description
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Advanced tab (Virtual Software Task Page)

Removal - 
Remove this task 
after successful 
install

Removes the software virtualization task (and associated package) from 
the Altiris Agent user interface on the managed computer. This does not 
delete the package from the managed computer. However, this makes it 
so that the user of the managed computer cannot view this task or 
associated package from the Altiris Agent program.

We recommend that you use this for tasks that you only want to run 
once.

Availability Specifies the date that this software virtualization task becomes 
available and whether or not it expires. You can also select whether to 
use the Notification Server’s time or the time of the managed computer.

Apply Click Apply to save changes.

Cancel Click Cancel to discard changes.

Advanced tab page items  

Item Description

Agent display 
name

Specifies the name of the software virtualization task that is displayed 
on the Altiris Agent. You can leave this blank and the default name will 
be used.

Agent display 
description

Specifies the description of the software virtualization task that is 
displayed on the Altiris Agent.

General tab page items (Continued) 

Item Description
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Status tab (Virtual Software Task Page)
The Status tab displays details about the execution of the task on the managed 
computers.

Enable verbose 
reporting of task 
status events

Select this to track all status events for this task. The status events are 
added to the log files.

Download and 
Execute Options

These options control how software virtualization packages are 
downloaded and executed. The default is to use the Altiris Agent 
settings found on the Altiris Agent Settings page.

Note
If you choose Use the following settings when downloading and 
running, these options override the default Download and Execute 
Options (found on the Altiris Agent Settings page) for this software 
virtualization task.

Download the package files as soon as possible - Select this to 
download the package files right away.

Download the package files before running the program - 
Select this to download the package files only when the program is 
required to run.

Multicast package - Select this to multicast this package to other 
client computers receiving the same package

Note
Multicasting must be enabled for a computer to participate in a multicast 
session. This is a configuration setting option available in each 
computer's Altiris Agent. This option can be found under Configuration 
> Altiris Agent > Altiris Agent Configuration > Collection Group 
> Altiris Agent Settings > Package Multicast. For information about 
multicasting, see the Altiris Agent Settings page and the associated 
Notification Server and Software Delivery Solution help.

Status tab page items  

Item Description

Display computers 
on which this task 
ran

Specifies the criteria for displaying computers on which the software 
virtualization task ran.

When you select an item from the drop-down list, a table is displayed 
with status information.

Advanced tab page items (Continued) 

Item Description
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Verifying that a Policy Has Been Successfully Delivered to the 
Altiris Agent Computer

To verify that a policy has been successfully delivered to an Altiris 
Agent computer using the Resource Manager

1. Open the Resource Manager to display information about the desired Altiris Agent 
computer.

For information on using the Resource Manager, see the Altiris Notification Server 
Reference.

2. In the left pane, click the Policy Summary item.

A list appears of all the policies that are enabled for the selected computer.

3. Verify that the policy you are checking for is in the list.

To verify that a policy has been successfully delivered to the Altiris 
Agent computer

1. In Windows Explorer or through My Computer, open the install path\Altiris\Altiris 
Agent\Client Policies folder (C:\Program Files\Altiris\Altiris Agent\Client Policies by 
default). 

This is where policies are stored on the Altiris Agent.

2. Using a text editor or Internet Explorer, open the notification_server_name.xml file.

3. Review the contents of the policy file and confirm that the policy you are interested 
in is included in the file.

Using the Software Virtualization Status Page
The Software Virtualization Status page is available when Software Delivery Solution is 
installed.

Note
For information on using the Software Virtualization Wizard, see Creating Virtual 
Software Packages (page 93).

The Wizard and Status page gives you access to the Software Virtualization Wizard 

and also provides status information for your software virtualization tasks.

To access the Wizard and Status page

1. In the Altiris Console, click the Tasks tab.

2. In the left pane, select Tasks > Software Management > Software 
Virtualization > Windows > Virtual Software Tasks > Wizard and Status.
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Software Virtualization Status Toolbar

The Software Virtualization Status toolbar contains icons which let you perform actions 
while using the Wizard and Status page.

The clickable icons on the Software Virtualization Status toolbar are as follows:

Right click menu - Provides a shortcut for the right click menu for the item.

Display for - Lets you select which tasks are displayed by age, number of rows, or 
status.

Edit - Lets you edit the task.

Clone Failed Task - Creates a copy of this task for the computers where it failed. 
Enter the name for the new copy and then click OK to create the copy.

Run Task Again - Runs the task again.

View task status details - Lets you view the success, failure, and not-run details 
of the task.

Page Items  

Item Description

Run Software 
Virtualization Wizard

Select this to access the Software Virtualization Wizard.

Use the Advanced 
Wizard

Select to run the Advanced Wizard.

Task list criteria 
check boxes:

Specifies the criteria for displaying available software virtualization tasks.

When you select an item from the drop-down list, a table is displayed with 
task information.

Created for 
approved software

Select this to display tasks that have been approved by the administrator.

Created for software 
requiring approval

Select this to display tasks that require approval by the administrator.

Scheduled by 
administrator

Select this to display tasks that have been scheduled by the administrator.
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Refresh - Refreshes the grid. Changes made to the grid will not appear until you 
perform a refresh.

Copy - Creates a copy of selected task row to paste elsewhere.

Find - Lets you search for a task in the table. Enter the search text in the Find field 
and then click the Find button.

Find Again - Finds the next task based on the last search criteria you entered in 
Find.

Grid right click menu - Provides a shortcut for the right-click menu for the 
selected row.

 See Creating Virtual Software Packages (page 93).

Managing Virtual Software Packages using the 
Resource Manager

You can use the Resource Manager to manage the state of Virtual Software Packages 
installed on client computers. You can do this in one of two ways:

If you change the state of the Virtual Software Package for a client computer, the 
following is automatically done:

A new Virtual Software Package is created with the program set to run the package 
in the specified state.

A new collection is created for that computer resource based on the package and 
state.

A new Virtual Software Task is created using the new package and collection.

By default, the new task is enabled, assigned to the new collection, and scheduled to run 
once, as soon as the computer is notified.

To manage Virtual Software Packages on a computer resource

You can view all the Virtual Software Packages imported on a client computer and 
manage their states.

1. In the Resource Manager, right-click a computer and click Manage Virtual 
Software Packages.

A list of Virtual Software Packages imported on the computer is displayed along with 
the current state.

2. To change the state of a package, click the state next to the package you want to 
modify, and select the new state from the drop-down list.

From the computer 
resource

Open a computer resource and view and manage the state 
of Virtual Software Packages on the computer.

From the Software 
Package resource

Open a Virtual Software Package resource and view and 
manage it on the computers it is deployed to.
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To manage Virtual Software Packages on the computers with the 
package installed

You can view all the computers that a Virtual Software Package is installed on and 
modify the state of that Virtual Software Package on those computers.

1. In the Resource Manager, right-click a Virtual Software Package and click Manage 
this Package.

A list of client computers with this package installed appears.

2. To change the state of the package, click the state next to the computer you want to 
modify, and select the new state from the drop-down list.

Note
For a list of package states, see Software Virtualization Solution Usage Overview 
(page 77).

Using the Software Portal
If you also have Software Delivery Solution installed, you can use the Software Portal to 
let users install software on their computers by executing software virtualization 
programs for which they have been given permission by the administrator. 

Using Notification Policies and Automated Actions
Software Virtualization Solution supplies Notification Policies that provide active 
reporting for the Altiris Agent.

Notification Policies automatically notify you when certain conditions exist. Notification 
Policies can be set on something as simple as a single software virtualization failure or 
specific set of conditions across multiple computers. Automated responses include 
sending of e-mail, running corrective commands and scripts, generating SNMP traps, 
and automatically generating a report and e-mailing you the URL of the report.

The automatic actions that can be taken by a Notification Policy are defined by 
Automated Actions. Several Automated Actions can be associated with a single 
Notification Policy. For more information on Automated Actions, see the Altiris 
Notification Server documentation.

The following table lists and describes the predefined Notification Polices.

Policy Description

Package Download 
May Be Too Late

Sends an e-mail containing a web report, which summarizes 
the computers where the package download might not be in 
time. You can adjust the percent download and the number of 
days warning (Day Filter). Example: Report computers with 
less than 60 percent download and 4 days before mandatory 
first execution. This policy applies only to Virtual Software 
Tasks with mandatory schedules other than ASAP.

Note
If you change the notification policy schedule, you must 
change the Days Filter parameter to match the interval.
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You can also create your own notification policies using the Notification Policy template. 
For more information on creating notification policies, see the Altiris Notification Server 
Reference.

Note
It is possible for multiple policies to monitor the same event. If you have more than one 
policy monitoring the same event, use caution so that the actions taken by the policies 
do not conflict with each other. Example: If two policies monitor the same event and the 
action taken by each policy is to add a log entry in the Notification database, you will 
have duplicate entries in your database.

Program Execution 
Failed

Sends an e-mail containing a web report summarizing failed 
program execution.

Note
If you change the notification policy schedule, you must 
change the Days Filter parameter to match the interval.

software 
virtualization Task 
Completed

Sends an e-mail notification when a Virtual Software Task has 
run successfully (at least once) on all of the targeted 
computers. Both mandatory and optional Virtual Software 
Tasks are reported. 

Note
If you change the notification policy schedule, you must 
change the Days Filter parameter to match the interval.

Note
Virtual Software Tasks with a repeating schedule will be 
continually reported.

software 
virtualization Task 
Expired

Sends an e-mail notification when a Virtual Software Task has 
expired and not all of the targeted computers have 
successfully run the program. Both mandatory and optional 
Virtual Software Tasks are reported.

Note
If you change the notification policy schedule, you must 
change the Days Filter parameter to match the interval.

software 
virtualization Task 
Expires In Less 
Than 7 Days

Sends an e-mail notification when a Virtual Software Task is 
about to expire and not all of the targeted computers have 
successfully run the program. Both mandatory and optional 
Virtual Software Tasks are reported.

Note
If you change the notification policy schedule, you must 
change the Days Filter parameter to match the interval.

Policy Description
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Part IV
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Deployment Solution Environment
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Chapter 11
Using Software Virtualization with Altiris® 
Deployment Solution™

You can use Altiris® Deployment Solution™ to install the Software Virtualization Agent 
on managed computers and deploy and manage Virtual Software Packages (VSPs) on 
managed client computers.

This chapter describes the following tasks:

Using Deployment Server to Install the Software Virtualization Agent (page 118)

Copying Virtual Software Archive Files to Deployment Server (page 119)

Using Deployment Server to Deploy VSPs (page 119)

Using Deployment Server to Manage VSPs (page 120)

Using Deployment Server to Uninstall the Software Virtualization Agent (page 121)

Using Deployment Server to Install the Software 
Virtualization Agent

This procedure explains how to install the Software Virtualization Agent on client 
computers managed by Deployment Solution.

Note
By default, the managed computer is restarted after the Software Virtualization Agent is 
installed.

To install the Software Virtualization Agent using a job

1. On your Deployment share, create a folder to store the agent and Virtual Software 
Archive (VSA) files. 

Example:

Create a folder named SVS with subfolders named Agent and VSAs, such as 
\\servername\eXpress\SVS\Agent\

2. Copy the Software_Virtualization_Agent.msi file into the folder that was just 
created.

3. Open the Deployment Console and create a new job. Example: Name the job, 
“Install SVS Agent and Restart”.

4. Add a “Distribute Software” task to the job.

5. In the task, browse to the Software_Virtualization_Agent.msi file and select it as the 
file to deploy.

6. Select the “Run in quiet mode” checkbox.

7. Under the Additional command-line switches add the following:
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PRODUCT_KEY=<product key>

For information about agent installation command line options, see Software 
Virtualization Agent Installation (page 65).

8. In the Code box, enter 1641. 

To see the definition of this exit code open a command prompt and type “net 
helpmsg 1641". It is a success code, but it is not recognized by DS as one.

9. Click Finish.

10. After configuring the job, drag the job onto the managed computer and click OK.

Copying Virtual Software Archive Files to 
Deployment Server

To deploy a Virtual Software Package (VSP), you must export the VSP to a Virtual 
Software Archive (VSA). For information on creating VSAs, see Getting Started with 
Virtual Software Layers and Archive Files (page 24). You must then make the VSA 
available to the Deployment Server. The easiest way to do this is to copy the VSA files to 
your Deployment Server.

To copy Virtual Software Archive files to Deployment Server

1. We recommend creating a unique location on your Deployment share to store your 
VSAs. 

Example:

\\servername\eXpress\SVS\VSAs\

2. Under the VSAs folder, create a subfolder for each VSA.

Example:

\\servername\eXpress\SVS\VSAs\AcrobatReader7

\\servername\eXpress\SVS\VSAs\Firefox 1.5

3. Copy the VSA files to the appropriate folders on your Deployment share.

Using Deployment Server to Deploy VSPs
This procedure explains how to create a job in Deployment Server to import a VSA and 
set it to activate on start.

To deploy a VSP using a job

1. From the Deployment Console, create a new job. Example: Acrobat Reader 7.

2. Under the job folder, create a new Copy file task. 

Example: Acrobat Reader 7: Import and Set Activate on Start.

3. Enter the source path where the VSA is stored on the share.

4. Enter a destination path for the VSA to be copied on the managed computer. 
Example: C:\windows\temp.

5. Click Finish.
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6. Create a new Run Script task inside of the job to call the SVS command-line 

interface.

Example:

SVSCMD.exe I -P “C:\windows\temp\AcrobatReader7.vsa”

SVSCMD.exe “AcrobatReader7” AUTO -Y

For a list of available command-line options and information on how to use them, 
see Using SVSCMD Command-line Parameters (page 51).

7. Select Windows as the script operating system.

8. Click Next.

9. Click Finish.

10. Drag and drop the computer on the job.

11. In many cases, depending on the application, after the job has completed, the 
managed computer may need to be restarted. You can do this using Deployment 
Server power controls.

Using Deployment Server to Manage VSPs
You can also use jobs to manage VSPs, such as resetting, deactivating, and deleting. 

To manage VSAs using a job

1. Create a new job. Example: Acrobat Reader 7: Reset.

2. Create a new Run Script task inside of the job to call the SVS command-line 
interface.

Example: To reset the VSP, use the following script:

SVSCMD.exe “AcrobatReader7” RESET -F

You can use a wide variety of command-line options. For a list of available 
command-line options and information on how to use them, see Using SVSCMD 
Command-line Parameters (page 51).

3. Select Windows as the script operating system.

4. Click Next.

5. In the Script Window option, select Hidden.

6. Click Finish.

7. Drag and drop the client computer onto the job.
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Using Deployment Server to Uninstall the Software 
Virtualization Agent

This procedure describes how to uninstall the Software Virtualization Agent from a 
managed computer using Deployment Server.

To uninstall the Software Virtualization Agent using a job

1. Under the job, create a new Copy file task. 

Example: Uninstall SVS Agent and Restart.

2. Enter the source path where the VSA is stored on the share.

3. Enter a destination path for the file to be copied on the managed computer. 
Example: C:\windows\temp.

4. Click Finish.

5. Add a run script task to the job to execute the following script: 

Msiexec.exe /x c:\windows\temp\Software_Virtualization_Agent.msi /q

6. Select Windows as the script operating system.

7. Click Next.

8. In the Script Window option, select Hidden.

9. Click Next.

10. At the Return Codes screen, click Add.

11. In the Code box, enter 1641. 

To see the definition of this exit code open a command prompt and type “net 
helpmsg 1641". It is a success code, but it is not recognized by Deployment Server 
as one.

12. Change the Response to Continue and Result to Success.

13. In the Status box, enter “SVS Agent removed, machine restarting”.

14. Clear the “Add to Master return code list” checkbox.

15. Click OK.

16. Click Finish.

17. Drag the computer to the job.
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Chapter 12
Software Virtualization Solution Technical 
Reference

This chapter provides additional Technical Reference information about Software 
Virtualization Solution (SVS).

Layer Attributes (page 123)

Layer Attributes
The attributes section contains the layer attributes for the registry redirection area. 

Attribute Description

ActivateTime The date and time at which the sublayer was last activated (value = 
binary_date_time)

Active The sublayer is currently inactive (value = 0) or the Read-only 
sublayer is active (value = 1)

ActiveOnStart The sublayer is active on system start (value = 1)

CreateTime The date and time at which the layer was created (value = 
binary_date_time)

Enabled Deprecated entry, not used

FileRedirect The path to the sublayer's file redirect area (value = 
Root:\Fslrdr\sublayer_folder_number)

ID The sublayer's globally unique identifier (GUID) (value = guid)

MajorVersion Combines with MinorVersion to indicate the sublayer's format: 
either blah (value = 0), blahblah (value = 1), or blahblahblah (value 
= 2)

MinorVersion Combines with MajorVersion to indicate the sublayer's format: 
either blah (value = 0), blahblah (value = 1), or blahblahblah (value 
= 2)

Name The layer's name; by default, the name of the SVP (value = 
layer_name)

PeerID The GUID for the sublayer's companion sublayer (value = 
companion_sublayer's_guid)

ReadOnly The sublayer's writeable status; either read-only (value = 1) or 
writeable (value = 0)

RefreshTime The date and time at which the layer was last reset (value = 
binary_date_time)

RegRedirect The location of the layer's registry data (value = 
SOFTWARE\fslrdr\sublayer_folder_number)
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Type The layer's type: read-only (value = 1), writeable (value = 1), or 
data layer (value = 2)

ShouldDelete (Optional) Indicates that Fslx.sys is lazily deleting the sublayer 
(value = 1)

Attribute Description
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